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	 “ In this chapter I’m going to look at some commonly used type effects. Beginning with outlined, shad-
owed and inline type. From what unites these logos is that they all use that kind of effect. These effects are easy to 
achieve and illustrate to using the appearance panel. Here are three examples which we can extrapolate to all the 
techniques we just saw. Note that I’ve converted the type to outlines. This isn’t necessary for the effect, but I’ve 
done this just in case you were following along with these files and you don’t have the fonts that I’m using.

Let’s begin with this example. I’ll select the type, now converted to outlines, come to my appearance panel, and I 
will start out by adding a white fill. And then I will come to the stroke and I’m going to start with a black stroke. 
And I want the stroke to go behind the fill, so crucially I need to drag the stroke underneath the fill on the ap-
pearance panel. Now when I beef up the stroke weight, it’s just going to go outside the letter shapes rather than 
encroach on the letter shapes.

I’m going to go up to that size. Now I need to add a second stroke in yellow. I’m come and add new stroke. I’ll 
choose the stroke that is at the bottom. Make that yellow and then increase the stroke weight so that it goes 
outside of the black stroke. And in this particular instance, with these letters, I want to make sure that that area 
between the L and the O fills in. So I’m going to increase the stroke weight to 15 points. Now for the second ex-
ample, like the first we have two strokes.

What differentiates this, is that the orange outline is actually a dropped shadow. If you look carefully, you can 
see that that is offset. So once again, I’m going to start with a fill color on the appearance panel. Then I will come 
to the stroke and I’ll start with the black stroke. Drag this underneath the fill and increase its weight. Then I will 
add another stroke coming to the top stroke now I’ll change the stroke color to white and decrease its weight.

So now I want the shadow to be on the stroke on the white stroke. So I will select the white stroke, come to my 
effect menu, stylize, drop shadow. Typically when you apply a dropped shadow, that shadow is blurred and at a 
opacity of less than 100% but in this case, we want the blend mode to be normal and the opacity to be 100. Let’s 
turn on the preview to see what we’re going to get. I want the blur to be zero, and I want the color to be that or-
ange color.

I’m going to come to my color swatches, that’s the color I want, and now I just need to adjust the X offset and the 
Y offset like so. For my third example, I want to use an inline effect. This uses this option, offset path. Now, I can 
tell you that it’s not going to work, but I want you to see why it’s not going to work first of all. I’ll choose to offset 
the path, turn on my preview, and then I need to increase the amount of offset, and this needs to be a negative 
amount so that it goes inside the letter shapes.

So minus six, say. And that’s going to create a whole new interior shape. And then I can give that a color. But the 
problem here is that the horizontal strokes are not as thick as the vertical strokes. And that’s because even though 
I began with a relatively mono-weight font, it was not completely mono-weight. So that’s what I need to do first. I 
need to adjust the letter shapes in order for this effect to work really well.

So I’ll delete that, then I’m going to select my letters, come and choose my rectangle tool. The vertical stroke 
is thicker. So I want to adjust the horizontal strokes to the thickness of the vertical stroke. I will draw myself a 
square that corresponds to the thickness of the vertical stroke. I’m holding down the shift key as I do that. And 
then I’m going to position that aligned with the bottom of the horizontal stroke.

Now I’m going to come and choose my direct selection tool and I’m going to increase my view size for a very 
precise work, it can be preferable to work in the outline view mode. That’s what I’m going to do. Then with my 
direct selection tool, I’m going to drag this part segment up so that it aligns with the top of that square. As I do 
so, to prevent any movement from side to side, I’ll hold down the shift key. I’ll then select this measuring rectan-
gle, or measuring square, and position it like so.

Actually, I want it to come in just slightly so that I can get to those anchor points. Because now I need to select 
that anchor point, hold down the shift key, select that one, that one and that one, and holding down the shift 
key, drag from one of the path segments like so. We can now delete that square, switch back to the preview view 
mode, and the keyboard shortcut for that is command or control Y. Now we can select our type, object, path, 
offset path.

I’ll go one point more in this case, minus seven. And then we can apply a color to that interior path. And we see 
now, that it is completely mono-white. So there, just three examples of what we can do with inline and outlined 
type.”

from Lynda - “Logo Design - Techniques”
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	 “-  Putting type around a circle can convey an official seal or stamp. For this reason, it’s often used to 
confer legitimacy and status on a brand. We see it with coffee houses, car companies, and rock bands. A broad 
range. If we just want type on an arc, we can use warp effects, but if we want the type to be read at the top and the 
bottom of the circle, we need to use type on a path. Let’s look at the warp effects first. So, here I have type on an 
arc, and then below it, type on an arch.

And you can see that with type on an arch, the example beneath, that keeps the edges of the type vertical, where-
as they’re going to be curved according to the percentage of the arc in the upper example. So if we move down 
here, I have two pieces of type to which we can apply the same effects. Select it, come to Effect, Warp, Arc, and 
let’s go with less than that, let’s just go with 30 percent, and now, let’s compare that to Warp, Arch.

The same amount. So let’s move now to this empty space on the artboard, and I am going to start out with my 
ellipse, draw myself a circle. I want the circle from the center point, and a perfect circle, so I’m holding down 
Option or Alt and the Shift key, as I do so. I will then come and choose my Type on a Path tool. Now, as soon as I 
click on that path, the fill is going to disappear. Anticipating what’s going to happen here, I’m going to click at the 
six o’clock position, and then put in my text.

I’m now going to center that text. I can use that icon right there, or I can use the keyboard shortcut, Com-
mand-Shift-C. And you’ll see that that immediately puts it centered at the top of the circle. Command-A to select 
all of that, and then I’m going to change the typeface to Chaparral Pro Bold, and increase the type size, Com-
mand-Shift, or Control-Shift, and the more than key. Now, I have my type preferences set up to just go a half 
point at a time when I do that, so I’m moving in very small increments.

That preference is right there. I want to go up to about that size. Now, before I put type along the bottom of the 
circle, let’s just look at the Type on a Path options. Rainbow, and typically, this is the one that I would use, but 
we also have the option to skew. And in this case, not such a good result, but you can clearly see the distinction 
there. We also have these other options, which, frankly, I’ve never found a use for, but never say never.

Maybe one day. I’ll put that back to rainbow. Now, what I want to do is essentially have a copy of this circle, and I 
can get this in one move. If I hold down my Option or Alt key, and then just drag from that tick, that tick rep-
resents the center aligned type. I’m going to drag from there, and into the center of the circle, and things can go a 
little bit crazy when you do this, and they have gone a little bit crazy for me. If you’re lucky, it will end up in just 
the right position.

In my case, it has not, so I am going to need to move that around. So I need to come and just spin that around 
somewhat, and what I have here is my beginning story and ending story markers. And this is what make Type 
on a Path potentially so confusing. I need to open that up, so I can see all of my type. Now, because this type is 
centered, there is going to be a mark at its center point. That’s the one that I want to get, and I want to drag that 
around to the bottom of that circle, like so.

Now, I’m going to select it, and type in whatever is the type that I want to appear on the bottom of the circle. My 
type is too big to fit within the bounds, I’m not going to worry too much about that, because I’m going to make 
the type smaller. I will select it, and Command-Shift-Less Than, to make it smaller, and then I’m also going to 
change its weight to Regular. Now the problem here, and you are always going to have to go through this step, is 
that the type is aligned relative to the baseline.

That works for the type at the top of the circle, but not for the type at the bottom of the circle. So I need to come 
to my Type on a Path options, and say, align to ascender. Turn on my preview, and you can see, that’s what we’re 
going to get. In addition to this, I need to shove the type up just a little more, so I’m going to press Command or 
Control-T, that’s going to bring up my Character panel, and then I’m going to show the options on my character 
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panel, because the option that I want is this one here, my baseline shift.

I need to shift it up slightly. I can use a keyboard shortcut for this also, which is Shift-Option or Shift-Alt and the 
up arrow, and that’s going in too big an increment, so I’m just going to nudge that down a fraction, and I want to 
end up with about a six point positive baseline shift. Now I can go ahead and adjust this more, adjust the relative 
sizes of the type, but essentially, that is the point that I want to get across, that for type to be read at the top and 
bottom of a circle, you essentially need two circles.

So the takeaway here is that if you want type reading both ways on a circle, you need two circles. I created the 
second circle at the bottom by holding down the Option or Alt key, as I dragged from the type on the top circle. 
If we look at the layers panel, I’ll click on the triangle to disclose the contents of Layer one, we see that here are 
two sub-layers. And if I hide the top one, we see just the bottom, and vice versa.”

	

Working with warped type

Warping type can create a sense of dimension, playfulness and tradition. We can achieve these results, some-
times easily, sometimes more painstakingly, using Illustrator’s warp effects, its 3D extrude and bevel options and 
the free transform tools. Here we have four different approaches to warping type. In this first example, I want to 
create a simple extruded shadow. I need to make sure I’m on the right layer.

I’m going to begin with an ellipse, select my type, cut my type, delete that empty text object, come and choose my 
type on a path tool, and then I’m going to click at the six-o-clock position, paste my type. I’ll change its color to a 
light grey and that’s so that we can see it distinctly from the extruded shape. I’ll now come to the effect menu, 3D 
extrude and bevel.

This is the angle I want, five, zero, zero. So you can see we’re just seeing that our shape is being upturned from 
the bottom and if we look at the preview, this is how it’s going to look. I’m going to set the perspective to 120 de-
grees. This is so that we can get a differing amount of shadow on the separate letters and when I press the tab key, 
you can see what’s happening there. And now I want to extrude it more than 50 points. Exact mileage, of course, 
will vary according to the size and style of your type, but I’m going to set that to 120 points.

I’m then going to change the direction of the light as being head-on. Not that that’s going to make much differ-
ence based upon what I’m going to do next. Just before I go further, I do notice that putting the type on a curve 
and adding that extrusion has caused me to want to apply some additional kerning to it. I’m going to come to the 
appearance panel. I’d like to bring the O and the T closer together. That’s going to be easier to do if I turn off the 
extrusion, double click to insert my cursor at that point and then I will press option or alt and my left arrow to 
bring those two letters closer together.

Now back to my selection tool, we can turn that back on again. And the next thing we want to do is expand this. 
‘Cause the object that we currently have is far too complicated. I’ll expand it and now I’m going to ungroup it. 
I’m going to ungroup it multiple times, so that I can regroup just the faces of the letter as one and the extruded 
shadow as another group. Ungroup and then do that as many times as necessary until ungroup is no longer an 
option.

Then with the direct selection tool, I will come and select the faces of the type, holding down the shift key as I do 
that, and then command G to group those together. Now let’s look on the layers panel. If I disclose the contents 
of layer one, we can see that we have this group here. I’m going to hide that and now select everything that makes 
up the extruded shape and simplify this by coming to the pathfinder and uniting it into one.

I’m then going to simplify it further by coming to the path menu and choosing simplify. Where the curve pre-
cision, I will set to 99 and we can see that we are halving the number of points. I can then apply the color that I 
want to that shadow, which in this case is green. I will turn the group back on and somehow things have gotten a 
confused in my order. I need to make sure that is above the shadow on the layers panel with the type selected.

I will change its color to that yellow gradient that I have on my swatches panel. I’ll use the gradient tool to change 
the direction of the gradient. Let’s go from top to bottom, might take a few goes to get that just right, I’m pressing 
there, command or control H, so that I can see my type without all the selected anchor points. OK, that looks 
alright. I’m now going to apply a stroke to that. And I’m going to click on the stroke options and set the stroke to 
align to the outside and I’m also going to make it lighter in weight.

I’ll now turn my edges back on, command or control H, and there is my first warped type option. My second op-
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tion is a whole lot more straight forward. All I need to do here is apply a bulge warp effect. And to the type only, 
so I’m going to select just the type. Effect, warp, bulge and then I just need to adjust the amount of the bend, so 
that the type fits into that shape. Now even though the type began as being vertically and horizontally centered 
within that shape when I apply the warp to it, that may cause it to not look like it is.

So I might need to then just adjust its position. Thirdly, I want this kind of effect that we see on the left where the 
size of the type decreases as we get closer to the end of the word. This is type on a path and if I select it, we can 
see that we have type on an ellipse and that ellipse is rotated at an angle. Now I have here the exact same type on 
the exact same ellipse at the exact same angle, it looks quite different.

Here’s what I did to it to make it look the way I want. Starting out with my type on a path options, I’m going to 
change that from rainbow to skew. Next, I need to add a warping effect. It could be any warping effect because 
what I want is not the bend, but rather the horizontal distortion. I’m going to turn the bend down to zero, and 
then for the horizontal distortion, I’m going to make that -20 percent. And look what that does to the type.

It’s now decreasing the further we get to the end of the word. And that’s OK, that gets us most of the way there, 
but I just want to go a little bit further by dialing this in, in a rather manual way. I’m going to select seven of the 
letters, everything except the L and I’m going to decrease the size by one point. Command, shift, less than. Now 
I just want to point out that my preferences, my type preferences are set up to adjust the size and leading by one 
point increments.

I’ll now select everything from the G through to the end. Do the same thing, and I’ll repeat that until I get to the 
end of the word. One step further, same approach, select everything with the exception of the L and this time I’m 
going to decrease the horizontal width. So I press command or control T to call up my character panel. This is 
the option that I’m after here, the horizontal scale and I’m going to decrease by one percent.

From the G through to the end, decrease by one percent. You get the idea. And it’s that attention to detail that 
is going to make all the difference. My fourth warping option is also rather labor intensive. We want the type to 
be warped at the bottom and the top. The bottom is easy, I’ll do that first of all. Warp, this is going to be an Arc 
Lower. I want to set the horizontal distortion back to zero and this time increase the bend enough to make that 
fill the space.

But it’s not going to work so easily with the top because as you can see from the finished example on the left, we 
want the cross bar on the T to come down on the left and on the right hand side. Let’s zoom in on this and I’m 
going to position this like so and I’m going to start out by increasing the vertical scale. Let’s open up the charac-
ter panel and I’m deferring everything to the T to begin with.

This is the vertical scale option. I’m going to increase that, I’m holding down the shift key while I click on that up 
arrow and I’m going to go to 330 percent. I’m now going to increase the horizontal scale to push the letters out to 
the left and to the right and that’s about as far as I can get it. I’m now going to convert to outlines, command or 
control, shift, O. And so that I can work on these letters individually, I’m going to ungroup, command, shift, G.

I now want to work on the T. Now, we can see that the vertical scaling has really done bad things to the vertical 
stroke on the T. We need to fatten this up a bit. So I’m going to select that anchor point and that anchor point 
and I’m going to move it to the left. Holding down my shift key, I’m going to tap my left arrow and do the equiv-
alent for the right. Now with my pen tool, I will add an anchor point at the top, hold down my command key so 
that I can switch to my direct selection tool, and I will pull that up.

I now need to massage this into shape and that may involve some back and forth, so if I don’t get it just right, 
please forgive me. But I’m going to move those two anchor points up. I’ll select this path segment, holding down 

the shift key. I’ll bring that out to the right and this one, again, holding down the shift key, the equivalent dis-
tance to the left. I’ll now select the O and I want to adjust this with the free transform tool.

The essential point here is that each letter is going to be adjusted individually with the free transform tool using 
the free distort option. I’ll start on the right and I’ll bring that down and then move over to the left and I’ll hold 
down the shift key and drag that down like so. Then I’ll come and select its opposite number, then we will do the 
same thing. The free distort option, bring it down and on the right.

And then we can do the same thing, of course, with the Rs. So we see there four examples of warped type. Some 
very straight forward and easy and off the shelf. Others far more labor intensive, but definitely worth spending 
the extra time.”
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Creating a Monogram

	 “- A well-designed monogram can confer a sense of pedigree and history on your brand. I’m going to 
demonstrate three approaches: fusing letters together, deleting a part of a letter and using negative space to 
infer the missing part, and interlocking letters. In all cases, I’m beginning with the letters already converted to 
outlines; and then once I did that, I ungrouped so that I can select the individual letters. Let’s start out with the 
fusing of two characters together.

When I select this S and move it back onto the R, essentially what I want to do next is use Pathfinder to combine 
the two together, Pathfinder or Shape Builder; but actually it’s a bit more complicated than that. I’m going to 
look at the outline view. It’s going to help me get a closer match. The two letters are too tight at the top, so I want 
to just extend the bottom left of the S. I’m going to hold down my Shift key, swipe over the bottom few anchor 
points with my direct selection tool and move that slightly to the left.

Now when I select the whole letter and move this back, and I’m going to zoom in again to get as close as I can, 
that is about as close a match as I can get. I’ll now come and choose my Shape Builder before I do style select. 
Both letters, my Shape Builder, and I want to be able to knock out just that shape right there; but you can see that 
when I do so, it’s leaking into the larger shape. So I will come up and get my direct selection tool and select that 
anchor point and move that down just a fraction.

Having done that, I can now get to just that bit by itself. I’ll hold down Option or Alt and click on that to subtract 
it and then continuing with the Shape Builder, I’ll fuse those two letters together. In doing this, you may find that 
you end up with a few bumps along the way. So to fix those, go and choose your pen tools. Now I’ve got an extra 
anchor point here that I don’t really need. I’m going to delete that one.

I might delete that one too, and let’s now delete that one, and then I’m just going to smooth this one out with my 
anchor point tool, and I’m keeping my anchor points perpendicular wherever possible, holding down the Shift 
key. And that’s just going to keep that point nice and smooth. Let’s now zoom out, and I didn’t do such a great 
job on it. Now let’s come back and just fix that up a little bit more. Basically where they join, you are going to 
have to do a little bit of nipping and tucking.

So now I’ll switch back to preview, and it still looks a little bit bumpy there; but with some more work, I could 
smooth that out. So now in the second example, I want to use negative space to infer the missing part of the 

letter, and obviously if you’ve seen the fantastic V and A logo designed by Alan Fletcher, you can see where my 
influence is coming from. I’m going to get the eraser tool. I’m going to begin with the eraser tool, and I’m doing 
this because the A is a compound part, and it needs to be a compound part because of the interior counter space 
and that can create some problems; and I found that if I start out like this with the eraser and just roughly erase 
the parts of the letters that we don’t want, I will then come and get my line tool.

I’m going to draw a line like so, continuing the angle diagonally there and the same thing right there; and then 
with the selection tool I’ll select the letter and those two lines, come to my Pathfinder and divide. Now my direct 
selection tool, I can select that bit and delete it and that bit and delete it; and I’ve still got a little bit left down 
there. Let’s just come and draw a rectangle over that, select that and the letter itself; and we will use the Shape 
Builder to swipe over both of those, and now I can move that in closer to the Y.

Thirdly, let’s look at interlocking characters. I’ll get the O and I’ll create some sort of interlocking arrangement 
like this. Obviously we need to be working with some colors here, so we’ll have dark blue for one and a lighter 
blue for the other; and I could use divide again here, but instead I’m going to use live paint just because as its 
name suggests, it remains live and I can change the interaction of the two letters.

So with them both selected, I’ll come and choose my live paint bucket; and then I just need to click on the group 
to make it into a live paint group and then click on that particular segment and that particular segment wants to 
be in the dark blue. So now we can see that we’ve got this nice interlocking effect and here’s the punch line with 
the live paint we can drill down and we can select the elements that make up that group and we can move them 
around and the interlocking remains live.

So there, three different approaches to creating a monogram.”
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Creating a handwritten logo

	 “-  There are many successful logos that use handwritten type. With handwritten type you can convey a 
personal, informal feel. A handwritten signature logo can also convey authenticity, and because it is unique it’s 
preferable to using an off-the-shelf script typeface. Here are three approaches to creating a handwritten logo. The 
first involves using the Brush tool to actually paint the logo in Illustrator. Here’s my first attempt. Let’s delete that 
and try again.

From my Brushes panel, from my brush libraries, I’ll come and choose this one. It’s the 6d Art Brush: medium 
17pt. And then I’ll just experiment with that. And after a while you’ll probably get a sense of where you want 
your descender to be, and your baseline, your X height, and the cap height. So, if that’s just a little bit too idiosyn-
cratic, I’ll draw some guides and then try again.

If I like that, and let’s just say for the purposes of demonstration that I do, then I can select it. Perhaps I might 
want to come and just make a few variations to the angle of the brush, possibly the size of the brush and its 
roundness. I’ll apply those to the strokes, and then from the Path menu I will choose Outline Stroke to make it 
all into fills. And then, from my Pathfinder panel I will unite all those shapes into one.

So, that’s the first attempt. The second attempt involves image tracing a sketch. On my Layers panel on the image 
trace layer, if I open that one up, you can see that beneath that image I have a sketch. So, now let’s try tracing 
this again. This was just created with pencil and gone over with a Sharpie, photographed on a phone, and then 
placed in Illustrator. I’ll select it, choose Image Trace, come to my tracing options, make sure that Ignore White 
is turned on, and everything else I think I pretty much want to leave as is.

To now edit those vectors I’ll expand, and I might need to just come in with my Eraser tool and fix up a few 
things here and there. If I wanted the letters to be a little bit fatter than they are, I could come to my Path, offset 
the path, and I’m going to offset it by one pixel. That’s going to create an interior shape. I’ll then swipe over that 
to select everything, come once again to my Pathfinder, unite all of that into one.

And then, in this example I feel there are just too many anchor points, way too many anchor points, so I’m going 
to try and simplify it by coming to Path and Simplify. And, let’s see. How low can we go before we start messing 
it up? I’m going to go with 96%, and you’ll see that about cuts the number of anchor points by a quarter. Now, 
thirdly, and I think most successfully, I’ll turn off those guides that I drew, ‘cause they’re now distracting.

I’ll also come and turn off the brushed layer. Rather than image tracing that sketch, I hand-traced the sketch. The 
sketch was very rough, and hand-tracing it allows me to improve upon it as I go, control the number of anchor 
points, and just make the whole thing a bit more uniform. So, here is the sketch. I’m going to convert it to a tem-
plate layer, which will dim it to 50%, then create a new layer above it from my paths.

I’ll tear off my Pen tools. Make sure I am working with no fill and a black stroke. I’ll put a very limited number 
of anchor points down, just creating straight line segments. I’ll create each letter separately to begin with. Now, 
switching to my Anchor Point tool, I will introduce curves and do my best to keep those curves perpendicular. 
I’m holding down the Shift key as I drag them. In addition, I can pull on the path segments themselves.

Using my Direct Selection Tool, I’ll select the end points and make sure that the letters actually join. And, con-
tinuing in this fashion, I will end up with outlined letters like these. You can see that I’ve intentionally deviated 
from the sketch. I can now go in a few different directions. Perhaps I’ll apply a brush stroke, and if I want to edit 
that brush stroke, I can come to its options, possibly change its size or angle, or, I’ll just undo that.

I can increase the stroke weight, and, in this case, I’m going to go up to 4.5 point. In addition to which I could 

use the width tool and possibly just decide to widen or narrow the stroke at certain points on the letters. I should 
point out that the stroke has a round cap on it. And then, finally, I’ll come to Object and Path and outline the 
stroke. That’s going to make that all into a fill as opposed to stroked paths, and then I can incorporate all the 
areas of overlap using the Pathfinder.”
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Perspective typeRendering letters as a halftone dot pattern

	 “- Here is a simple perspective type technique. Works very well when you have a word with an odd num-
ber of letters and you can pivot that word on the middle letter. And this is a non-destructive technique, it’s live, 
so we can always change the wording afterwards should we need to do so. The type I’m using is Proxima Nova 
Extra Condensed. If you don’t have this, it is available in Typekit, but if you don’t have access to Typekit, then use 
a Sans Serif typeface, preferably a condensed Sans Serif typeface.

So with my type selected, I’m going to come to the Appearance panel. The first things I’m going to do is, with the 
fill property active, press forward slash to apply no fill to that. I’m now going to add two fills through the Ap-
pearance panel. So I’ll click on that twice. The top fill will be black and the fill below that will be grey. Returning 
to the top fill, I’m going to apply a 3D rotate to this.

Effect, 3D, Rotate. For the position, I’m going to change that to Isometric Right, turn on my Preview, and that’s 
what we’re going to get. And I’m now going to come to the grey fill beneath that, back to the Effect Menu, Rotate. 
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This one will be Isometric Left. I’ll come back to the top fill because I actually want to move this down ever so 
slightly so that they align slightly better than they are right now.

Back to the Effect Menu: Distort and Transform, Transform, and I’m going to use the vertical move, let me turn 
on my preview, and then I can just click into this field and nudge it. It seems a bit counterintuitive but I’m in-
creasing the value and that’s moving it down but anyway, there we go. I’ll click okay to that. I now optionally 
want to add a shadow as well, so I need to add another fill.

This fill needs to come down below my two existing fills. This is going to have the very light grey color apply to 
it. I’m going to come to the Effect Menu, 3D, Rotate, position will be Isometric Top. Click okay. Back to the Effect 
Menu, Blur, Gaussian Blur. I’m going to blur it by 10 pixels. As I did with the top fill, I want to use the transform 
effect to slightly move the position of the shadow relative to the type.

Effect Menu, Distort and Transform, Transform. There is some trial and error involved here to get this right, but 
I want to move it by 25 points horizontally, and vertically by about 10 points. As I mentioned, this is a live effect, 
so if I do need to change the wording, I can double click on characters at the bottom of the appearance panel. 
That will select the type and then I can just type in my new type and that effect will be applied to it.

Optionally, I could also save this as a graphic style, so that next time I create some type and I want that effect 
applied to it, I can do that through applying the graphic style.
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Rendering letters as a halftone dot pattern

	 “- Let’s see how we can create letter forms from a simulation of a half tone dot pattern. I should say that 
effects like color half tone, which you can find under the Effect menu, pixelate, color half tone, and the half tone 
pattern, are really not going to cut in this context, because they don’t give you the required amount of control. 
Instead, what I’m going to do is rastorize the type, convert the type into an object mosaic, and then convert the 
square mosaic tiles to round dots.

In addition, I’ll make several sizes of dot, which I will save as graphic styles. Okay, so, my type, which I’ve al-
ready converted to outlines, using this option, began as OCRA 150 points, to which I added an eight point black 
stroke, just to beef up its white. But as I say, that’s already been converted to outlines. So my next step is to apply 
a Gaussian blur.

And I’m going to do this to introduce more gray values. So I’ll come to the Effect menu, blur, Gaussian blur, and 
I want a blur of 10 pixels. Next, I’m going to rastorize the type. Object, rastorize. And in this case, I’m going to 
use a medium resolution of 150. And I’m also going to add two millimeters of space around the object.

Now I want to take my rastorized type and convert it to an object mosaic. So, what we’ve actually done here is 
convert vectors to pixels, and now we’re going from pixels back to vectors. Now, how many tiles you have, you’ll 
need to experiment to get just the right number of tiles. I’ve found that, to create just a simulation, rather than an 
authentic looking half tone, but a simulation of a half tone, fewer tiles were actually better.

So I’m going to go with 50 in width, and then I’m going to choose use ratio, and that will give me a proportional 
number of tiles in height. And I also want to make sure that I’ve got delete rastor checked, so that it deletes the 
original rastor object. The image is now made up of a grid of pixel-like squares. And I want to ungroup these, 
deselect, click on one of the white squares, and then come to the Select menu, Same, Fill Color, and delete all of 
those.

Now, zooming in. So I’m going to select one of the darkest squares, come to the Effect menu and choose Convert 
to Shape, Ellipse. I want the size to be absolute, and I want the size of my largest dot, in this case, to be 2.75 milli-
meters. I’ll click okay. I now want to create a graphic style based upon that. Let me make sure that the color here 
is black, and then I will come to my graphic styles panel, where you can see that I already have some premade.

I’ll choose new graphic style, and I’m going to type in the size, 2.75 mm. I’ll click okay. Now I’m going to choose 

to view my graphic styles as a small list. Switching now to my magic wand, I want to select all of the dark squares 
and apply that same graphic style to them. So now let me choose one of the darker gray tiles.

I’ll start out by applying the same graphic style to that, and then using the appearance panel, edit that effect, and 
reduce the size. And in this case, I’m going to go down to two millimeters. Click okay. I’ll make a new graphic 
style. I’ll call that 2mm. Come to my magic wand tool.

And I have quite a few different shades of gray here, but to simplify things, and I think it’s going to work better if 
it’s simpler, I want to use just three sizes of half tone dot. So I’m now going to select all of my dark grays and mid-
dle grays, and apply that lesser size of half tone dot. I’ll now switch back to my direct selection tool, choose one 
of the lighter grays, start out with the two millimeter dot, come to my appearance panel, edit the size of that dot.

And I’m going to go down to 1.5. Click okay. Create a new graphic style based on that size. Back to my magic 
wand tool, and select all of the light grays. And then apply that smallest size of dot. And there is our overall ef-
fect, with the type now made up of three different sizes of half tone dot.”

Creating a vintage label

	 “-  Let’s create a vintage label. My vintage label has a color pallet suggested by this vintage poster. I 
sampled these colors and I saved them as a color group. And they are on the swatches panel. I’m not going to 
go through the steps of doing that because I cover that elsewhere in the course. But with my color pallet deter-
mined, I’m now going to create a circle as my starting shape. And I want to fill this circle with a gradient.

It’s going to be a radial gradient. I want to make sure that it has no stroke. Now to change the colors of the gra-
dient, let me tear off the gradient panel and open up the swatches panel as well. I’ll click on the starting gradient 
color. Hold down the alt key and click on the lighter of the two blues. Click on the ending gradient color alt key 
and click on the more saturated of the two blues.

Let’s now pop the gradient back into my docked panels. And come to the appearance panel. I’ll click on the fill, 
and what I’m going to do now is apply the zig zag effect around the edges of the circle. So, distort and transform, 
zig zag. I would like the size to be three points with 20 ridges. It’s going to be absolute and smooth.

I’ll click OK. I now want to add a stroke. So I’m going to come and click on the stroke. I will change the color of 
the stroke to the off-white. And the weight of the stroke to two. Now to move the stroke inside the circle, like we 
see over here. I’ll come to the effect menu, distort and transform, transform and use a scale of 93% both horizon-
tally and vertically.

Next I want to add the type. Choose my type tool, click. Type the word vintage, select that. Press command or 
control + T to bring up my character panel. The typeface I’m using for this word is called Boucherie Block Bold. 
It’s by Laura Worthington and it is available on Type Kit. The size that I’d like to use is 79 points. And I’d like 
some positive tracking in this case 25 points.

I will horizontally align it center, and then visually align it within the circle just by dragging it into position. And 
I think I just need to make that a little bit smaller. So I’m just going to scale it holding option shift and scale it 
down. So let me now apply a gradient to the type. And lets do this through the appearance panel. I’ll click on 
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New Fill, click on that fill, and I have a gradient there.

It’s not actually the gradient that I want, but I’ll start out with this. I’ll just apply that gradient, come to the gradi-
ent panel and once again, I’m going to tear this off, open up my swatches panel. My starting gradient stop will be 
the red. And my ending gradient stop will also be the red. I want to make sure that both gradient stops have an 
opacity of 100. Then with the ending gradient stop, I’ll select that, double click on it, show my color sliders and 
increase the amount of black that is in that.

Let’s go out to about 50% I want to change the angel of the gradient, so I’ll do that with the gradient tool. And 
I managed to get that the wrong way around, so I’m just going to put a minus in front of that angle, and we’ll 
round it off to -90, just because I’m superstitious about those kind of things. Okay, so what we’re after there is just 
the text to be slightly lighter at the top. We’ll also get the mid point and move that over toward the darker of the 
two reds.

So now let’s get back to the appearance panel where I’m going to add two strokes to the type. I have one already 
here. This currently has none applied to it. I’ll apply the blue of the background to that. And I will increase it’s 
weight to three points. I’m going to move it beneath the fill so that it doesn’t interfere with the latter shapes. And 
then I will add a second stroke, and this one needs to be beneath the blue stroke.

And this will be the off-white color. It’s weight needs to be more than three points, I’m going to go for five points 
so that we can see it. And then I’m going to transform it so that we offset it. So that we can see this more clearly, 
let’s just increase the view size. I’ll come to the effects menu and transform was the last effect that I used, so I can 
just choose it from there or from here.

And I want to move it two points horizontally and vertically. I’ll press command minus just to zoom out slightly. 
Back to my type tool, I’m now going to add the smaller type which just says San Francisco. I’ll select that, change 
the typeface to a script face called Voltage, with a size of 24 points and a fill color of the off-white.

If I can position that. Duplicate it by holding down the option or alt key and dragging away from it. Selecting 
that and just typing the new text over it. Now to add the circular type, I want to make sure that I’m drawing a 
circle that’s centered on the circle that I already have. So I will select this circle and just mark it’s center point by 
drawing some guides. And if you don’t see your guides, as I do not, Come and show the guides.

So I’m going to draw my circle to about that size. And as soon as I click on it with my type on a path tool, the fill 
of the circle will disappear. To add the type at the top of the circle, rather counter-intuitively I’m going to click 
at the bottom at the six o’clock point on the circle and then type my text. I’m confident that I want it in all upper 
case, so I’m just going to press my caps lock key while I do this.

I’ll select it. I will change it to Filson Soft Regular. Change the size to 18 points and the color to the off-white. 
Now for the type that runs along the bottom of the circle, I will select the circle, copy it, command C, paste it in 
front, command or control F, grab the marker that indicates the type alignment, drag that down and inside the 
center of the circle.

I’m going to switch to my type tool. Select it, then type in the text that I want at the bottom of the circle. I’ll select 
this text, come to the type menu and to adjust its position relative to the edge of the circle, come to type on a 
path, type on a path options. I will align it relative to the ascender. And then using my character panel, I will just 
shift it up ever so slightly using baseline shift.

Now to finish off our label, I’m going to add some texture. And I’m going to do this by working with an image 
file and tracing it, then converting the traced result to a symbol and painting with that symbol. Moving now to 

the second art board in this document, I have here my texture file. I’ll click on image trace and then click on my 
trace panel to modify the tracing options. I’ll toggle open the advanced options.

The noise slider, I’m going to bring this down all the way to the left. That’s actually going to increase the amount 
of detail in the tracing result. And I want to turn on ignore white. Now to expand the result, I will click on the 
expand button. There’s a lot of information here that I don’t want. I just want this small portion of dirt right here. 
So I’m going to get my direct selection tool, zoom in, first of all, and then just isolate these bits that we don’t 
want, swipe over them, delete.

Until we’re left with something like this. I’ll now select this. I’ve got a little bit extra down there. Let’s get rid of 
that. I’ll select it, close the image trace panel, open up my symbols panel, and then I’m going to drag this onto the 
symbols panel to make it into a symbol and click OK.

Before I go any further, just make sure I deselect that template for my symbol. And come over to my symbol 
tools. I’ll tear these off. Beginning with my symbol sprayer, so this is the main tool that I’ll be using. I can change 
the size of the brush by pressing right square bracket to go bigger, left square bracket to go smaller. And I’ll just 
add in some texture.

I can use these symbolism tools to modify that. I might want to spin some of these around slightly, or possibly 
change the size, so I use the symbol sizer tool. If I hold down the alt key or option key and click, then that will 
slightly reduce the size of each symbol instance. When I’m happy with how this looks, I’ll come to the transpar-
ency panel and change the blending mode to soft light.

And then I will change the opacity to 50%. Now just to finish this up, I need to add a clipping mask which will 
clip any instance of that texture that went outside the shape. I’m going to do this using the layers panel. I’ll tear 
off the layers panel and look at the contents of this layer. So we have here the ellipse. This is the defining shape. 
What I’m going to do is select this, and hold down the option or alt key and drag up a copy of that to above the 
symbol set.

Now with this copy selected, I’ll come to the appearance panel where I will delete the stroke. And then I will 
come to the object menu and expand its appearance. So now extending the selection to the symbol set below 
by holding down the shift key, I’ll press command or control seven, and any fill property on the top shape will 
disappear. And it becomes a clipping shape. So now let me just hide the guides and there is our finished vintage 
label.



- 32 - - 33 -



- 34 - - 35 -



- 36 - - 37 -

LINES

	 “- Many logos use lines as an effective graphic element. The style of the line, the weight of the line, the 
color of the line, the number of lines, and how the lines interact with the type are just some variables. Lines can 
underscore a name, direct the eye, form barriers, suggest connections, or indicate movement. So here are four 
techniques for working with lines. Firstly, don’t underestimate the power of a simple underscore. In this case, the 
underscore is actually a rectangle, and I’m going to draw the rectangle so that it is the weight of the horizontal 
stroke of the type.

So I’m actually going to draw it over the type to make sure I can match it to the type. I want to make sure that it 
has a fill rather than a stroke, so I’ll switch those properties. And then in terms of spacing it relative to the type, 
I’m going to use the weight of the rule as a spacer. So I’ll make a copy of that holding down shift + alt, or option, 
and then I’ll move this one that I originally drew down, like so.

I can delete that spacer, and there’s the weight of my rule. Now I might decide as I did above, that I want the 
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weight of that rule to be twice what it currently is. So I’ll just select it. I’ll come to the transform panel. Come to 
the height property. Make sure that the constrain width and proportions property is not checked. And then I’ll 
just type in an asterisk two. Secondly, we could have the line be a more organic, more painterly line.

And this I created with the brush tool, so I’m just going to recreate that like so. Maybe I want to apply a different 
style of brush to it. How would it look with a ten point flat? And then perhaps I want to come to my calligraphic 
brush options and I can adjust the angle and the roundness of that brush, and also its size until I get something 
that I like. And I got to say I don’t really like that too much, but how would it look if we had some sort of artistic 
treatment applied to it? We have a number of different options in our brush library.

Thirdly, we can think about using lines as a way of conveying perspective. In this example, I want the lines to 
convey train tracks. So I’m gonna start with simply two grouped rectangles on a red triangle, and then come to 
my free transform panel, to the free distort option, and then distort these to create a sense of perspective. Just to 
finish this one off, I would want to make sure that I don’t have these solid white areas overlapping the triangle.

So I’m going to select the triangle, copy that, select the rectangles, paste in front, cmd or ctrl + f, hold down my 
shift key, and then come and select the rectangles and then make that into a clipping mask. From the object 
menu, clipping mask, make. And then, lastly, we could create an effect like this, where we have a series or blend 
of lines that overlaps a shape.

I’ll start out with the line tool. Let’s make the stroke of that line black, and I’m going to now duplicate that line 
holding down option or alt and the shift key, dragging away from it. I’ll then come to my blend tool and blend 
from one point on the line to the equivalent point on the line. Double click on the blend tool to specify the 
blending options. Now currently I have a specified number of steps. That is, in fact, what I want.

But, you may start out with this option, smooth color, in which case, you’ll have this effect. Not what we want. 
Specified steps. I’m gonna go a few fewer than that. Let’s try 40. Now, we have a number of different ways that we 
could mix this up. Perhaps I could make the top line a lighter weight. If we go from a .25 and then I’ll make the 
bottom line a heavier weight, to a 2.0, we get a blend in the white. I could also experiment with color.

I could change the angle on the whole blend, etcetera. I could have the blend only go over part of the shape, and 
ultimately we want to confine the blend to within the shape. Just one other option though, before I do that. I’m 
going to back up by pressing cmd + z, cmd or ctrl + z a couple of times just to get back to my uniform strokes. So 
I have one point stroke blending to a one point stroke.

I’m now going to change the width profile on this. And I’m going to use width profile number four. And we will 
blend two with profile number four. And sometimes, that does not work. I need to select both of those and then 
come and change them both together to get my width profile. That didn’t work before, when I changed the lines 
individually, but now when I have them both selected, and change the width profile, it does work.

That does also make me want to increase the weight. But now what I’m going to do is come and select the sur-
rounding shape, come and select that circle, copy that, select the blend, paste the circle in front of the blend, hold 
down the shift key, and select the blend and circle together, and make that into a clipping mask. If I need to edit 
the contents of the clipping mask, I can select it and then on my tool options, click on this icon here to edit the 
contents and then I can reposition or modify those contents as necessary.

So there are four different approaches to incorporating lines into your logo.”
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		  Arrows

	 “-  We see arrows used in logos in all sorts of ways, some obvious, some subtle. Because we read in the 
western world from left to right, arrows typically point to the right, following the reading direction. Sometimes 
they point up, but seldom do they point to the left or down. The easiest way to apply arrows is to apply the most 
arrowheads to a stroke. We have a number of different arrow styles and I’m going to reduce the percentage in this 
case to 40 percent.

I can make it extend beyond the tip of the stroke and I can also change its direction. To make the arrow imply 
a smile, I will add an arc lower warp effect to it, in this case it’s 75 percent, to then give it more personality or 
change the variable width profile to width profile one, move that closer to the type. Staying with that theme, if I 
copy that holding option or alt as I drag away from it or move the stroke above the type, come to the appearance 
panel, remove that particular effect, and replace it with an arc upper at the same percentage and we now imply 
the traversing of an obstacle.

I’ll use the polygon tool to create a triangle holding down the shift key to make sure it’s on a flat base, if neces-
sary press your up or down arrows to add or remove sides. I want this to be filled, not stroked, I want to rotate it 
through 90 degrees. I’ll type A to go to my direct selection tool and then round its corners just to make it a little 
more friendly, and now size it relative to the type. I’ll draw myself some guides to help me do that, like so.

Here I’m using an italicized type to give a sense of dynamism and I want to add the arrow to the letter E. I’m 
going to position this over the letter. I’ll come to my shear tool and I want to shear this at the same angle as the 
type. If I can adjust the scale, its position, I’ll select the type, convert the type to outlines, ungroup the type so I 
can select the letters individually, and then select the E and the arrow holding down the shift key, come to my 
pathfinder, combine those two shapes into one, zooming out, select all of that, and regroup it.

In this instance I’m going to begin with a right angle triangle, round the corners slightly, come to my anchor 
point tool and pull in the path segments to stylize the arrow. We can have a repetition of arrows. I’ll start out 
with this one optional alt and click on the bottom anchor point, rotate through 90 degrees making a copy, repeat 
that transformation, command or control D, select all four, group them together, hold down the shift key as you 
rotate to rotate to 45 degrees.

Another repetition, or you could take that one triangle, I’ve made the white of the stroke on the triangle equiva-
lent to the white stroke of the type. I’ll now choose the rectangle tool, my draw behind mode, select the type, and 
draw myself a rectangle tightly behind that type and fill it with white. We see arrows used everyday in icons and 
we understand these icons instantly. Here I’m going to start with a circle and make this into a refresh icon signi-
fying rejuvenation and renewal.

I’ll use my scissors and cut that circle in two places, delete the unwanted segment, select the stroke, and come 
and apply an arrow to that and significantly reduce its percentage. Or we can combine a triangle with a circle 
to create a map pin. Or we’ll just need to add in a solid circle on top of that to complete it or we daily come into 
contact with arrows in the form of mouse cursors.

Here I’ll rotate this through 22.5 degrees, that being the angle of a mouse cursor, actually half of 45. To finish 
that I would outline the stroke, combine the two elements into one, apply a white stroke around the result, if we 
look closely we see we have a slight kink in that line right there so I’m going to select that anchor point and that 
anchor point, and then aligning to selection I will make sure their left edges are aligned and I can now put that in 

position.

We also see arrows in the negative space of our artwork. In this case, the KD letter combination when tightly 
kerned, I can accentuate that by applying a color to it. When we think of arrows, we think of direction. When we 
think of direction, we think of a compass. So maybe we could work with this theme. And I have three iterations 
here going from the overly complicated at the top down to I think the more simple down at the bottom. And 
finally our arrows don’t need to be straight.

By making them zigzag we can have them convey danger, electricity, thunder, or roadside signage. I’m going 
to select both of these and then apply arrow number seven, 70 percent, and then to give it more personality I’ll 
select the stroke and then come and use my width tool to make that stroke wider at certain points.”
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	 - [Instructor] Continuing with the theme of arrows, I want to recreate two very successful logos that 
use arrows. The recycle logo and the British national rail logo. Now why you wouldn’t want to use these in your 
logos, deconstructing them can provide you with very useful techniques which you can adapt to your own needs. 
Let’s start out with the recycle logo. I’ll come and choose my direct selection tool and I now want to round the 
corners.

In this case, I’m going to round the corners by nine points. I’m now going to choose my scissors tool and I will 
break this rounded triangle in three points. There, there, and there. I’ll select those three, now separate, path seg-
ments, come to my stroke properties and add an arrow to each of them. I’ll have to dramatically reduce the scale 
and I also want to, in this case, make sure that I extend the arrow beyond the tip.

I’m now going to outline the strokes so that we make the stroke the stroke into a filled path. Let’s zoom in on this. 
I’ll choose my rectangle tool and I’m going to draw a rectangle, the right edge of which connects with the tip of 
the arrow. And it might be preferable to work in outline mode for this next portion. And I’m going to duplicate 
that rectangle and I want to rotate it through 60 degrees. And then duplicate it again and rotate it through minus 
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60 degrees.
So I’m positioning each of these at the tip of those arrow heads. Now let’s go back to preview. I’ll select all of that 
and come and choose my shape builder because I now want to remove these segments. Holding down option or 
alt and we will swipe over those pieces. With what remains, I will come to my pathfinder and unite all of that into 
one shape. Let’s now have a go approximating the national rail icon. This is one of the most readily identifiable 
logos in the UK.
And it’s a great example of how something so simple can convey so much. I’m going to begin with two parallel 
lines and then come to my stroke panel and apply arrow number 12. I’ll deselect. They are currently grouped so 
I’m going to ungroup them. Command shift G and select just the bottom one. Back to my stroke panel, change 
the direction of the arrow. Now I’m going to move this so that the arrows coincide.
I’ll now select both, command C to copy, command F to paste in front. On the ones that are in front, I will come 
and remove the arrows, and then going to select that stroke and move the top one to the right. I’ll select the bot-
tom stroke and to transform, move and I’ll move it the equivalent distance to the left. And now select everything 
from the path menu, outline the stroke.

Using pathfinder, I’ll combine those shapes into one. Now I’ll choose my rectangle tool, I’m going to draw a rect-
angle around this and I need to make sure this rectangle has no fill that aligns with this blunt end of the bottom 
stroke and the equivalent line on the right hand side and that it intersects the arrows so that it’s going to flatten 
them off like so. And now select everything, come to my shape builder, option, delete all the pieces I don’t need.
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Circles and ellipses

	 “- [Instructor] Circles and ellipses are loaded with symbolism. In a circle we have a ring, the sun, the 
moon, a wheel, an eye, a face, a speech bubble. Give the circle volume, and we have a sphere, and in a sphere, we 
have a globe. A circle can enclose the type. Here on the left, I put the type in all caps, so that it better fits the cir-
cle, and onto two lines. We can have a circle crop an image to a circular shape. I’m going to select this surround-
ing circle and copy it, select the image, Command- or Control-F to paste a copy of that circle in front, hold down 
the Shift key, extend the selection to the image, and then make that into a clipping mouse.

A circle can provide a spotlight on part of the type. We can reverse the type from a circle. I’m also going to add 
a stroke to this circle. I had a one-point stroke, and I want this one-point stroke to move inside the circle. I’ll 
transform it, and we have that effect. If your logo name is long, using an elliptical shape may be preferable. You 
can rotate the ellipse for a futuristic feel.

You can take this further and make the ring interlock with the type. I’m going to select the ring and convert it to 
a fill by outlining the stroke. I’ll then extend the selection to the type and create outlines. Choose the Live Paint 
Bucket, click to make a Live Paint Group, and I’m now going to just fill that segment there and that segment 
there with black to create an interlocking effect. The circle can be broken.

I’ll use my Scissors Tool, break the path in two places, delete the unwanted segment. I’ll take this further by 
applying a Variable Width Profile. Alternatively, I could use a filled rectangle behind the type. I’ll draw myself 
a rectangle, switch the fill and stroke properties, make the fill white, send that to the back, select the circle, and 
then send that to the back. We can work with abstract shapes.

I’m going to divide this circle, delete that portion, select those two open end points, join them, select what I have, 
move that up to the first line, use my Reflect Tool and reflect that across the vertical axis to create that abstract 
shape. Or I could divide the circle with a wave. I’ll come and fill that stroke with white, and let’s increase the 
stroke white, and we’ll then outline the stroke, select Circle and Stroke, and I could use the Shape Builder.
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I’m actually going to use the Live Paint. Click to make a Live Paint Group. I can now fill these segments individu-
ally, and I’m going to apply None to those pieces on the end. We can transform a circle with a zig-zag effect. If we 
add a triangle to a circle, we make it into a speech bubble if we have circles of descending size, we have a thought 
bubble. So there are just some of the many, many things you can do working with circles in your logos.
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Triangles and diamonds

	 “- Triangles make compelling shapes, either alone, as part of a pattern, or as an interior shape within a 
design. Put two triangles together and you have a diamond. Because of their reduced volume, triangle and dia-
mond logos tend to have the text stand outside the shape. Here are some techniques for working with triangles 
and diamonds. Let’s use the Polygon tool to create our triangles. We can click to do it numerically, but of course 
it’s easier just to click and drag.

If I want the triangle created from it’s center point, I will hold down the Option or Alt key. If you find you have 
too many sides, you can reduce the number of sides, I’m increasing the number of sides there by pressing the up 
arrow, but to reduce them press the down arrow until you get to three sides, and if you want it to have a flat base, 
hold down the Shift key. Now at this point you wish you had more hands, because you can also move it while 
you’re drawing it, and this is true of any of the shapes, if you hold down the spacebar before you let go of the 

mouse.

So there’s my triangle which I will now give a solid fill to and no stroke. If I want to round the corners on the 
triangle, I can come to my Direct Selection tool, and pull in on the targets. If I’m working with an earlier version 
of Illustrator I won’t have that option, but I can get the same result by coming to the Effect menu, Stylize, Round 
Corners... If I want to triangle to become a play button, all I need to do is rotate it through 90 degrees.

If you want to visually segment an equilateral triangle, which is what you’re going to get with the Polygon tool, 
use the Line tool. I’m going to start out with the Line tool, and let’s make sure that the triangle itself is not select-
ed, I’ll have a fill of none, and a stroke color of white, and then using my Smart Guides, I’m going to draw a line 
at 30 degrees, and I’m going to stop when I see my Smart Guide indicating that I’m at the center point.

I’ll then draw down another from the top, and another from the bottom right like so. Alternatively, we can start 
with a square, and divide it into four by drawing diagonal lines across the square, selecting the lines and the 
square using our Pathfinder Options, divide. So we now have four triangles, I’ll use my Direct Selection tool, so I 
can select them individually. Select that one, and come to my Reflect tool.

Alt-click on the left edge of that triangle, and reflect it vertically through 90 degrees. Now select it’s opposite 
number. Go back to the Reflect tool, and do the same thing. If you want a right-angle triangle, start with a square 
then use your Pen tool, and delete one of the anchor points. Here I’m going to adjust the scale of the triangle. I 
want to pull it in on both sides, so I’m going to hold down the Alt or Option key, I will also add an anchor point 
so that I can manipulate its shape, I’ll do that with the Pen tool, press “p” to access my Pen tool, I’ll add an an-
chor point at its center, press “a” to access my Direct Selection tool, then holding down my Shift key, I’ll pull that 
anchor point down.

To create a dimensional triangle like the Google Play logo, start out by making sure that you have a round cor-
ner join. Select the triangle, up to the stroke, and choose Round Corner. Let’s just take a look at how that looks. 
There’s the round corner, and that’s how it is before, and that’s how it is with the round corner. So now what I’m 
going to do is come to my Scale tool, hold down the Alt or Option key, and click on the top anchor point of the 
triangle.

Make a copy, a Uniform copy, at 25%. Now hold down the Shift and the Alt key, and drag that copy down to the 
bottom of the triangle, and then holding down the Shift key, drag it over to the left of the triangle, until it inter-
sects with the path. Now holding down the Shift key and the ALt or Option key, duplicate another copy over to 
the right hand side. Select all four shapes, come to the Shape Builder, hold down the Option key, and delete the 
ends.

Switch to the Line tool, zoom in. Let’s draw lines from anchor point to anchor point. Select the whole shape, use 
the Shape builder. Combine those segments, those segments, those segments, hold down the Option or Alt key 
to delete the interior segment, now let’s apply different colors or tints to the individual segments, and optionally 
make the stroke property none.

You can easily make a triangle into a diamond simply by reflecting it across the vertical axis, making a copy, se-
lecting both using the Path Finder to unite the two. I’m also in this case going to have an interior copy at 50%, I’ll 
then select both holding down the Option key, I’ll scale them like so, and then move the result into position.

Finally, we can rotate multiple diamonds around the center point. I’ll select the one diamond, press “r” to access 
my Rotate tool, hold down Option or Alt, click on the anchor point, and in this case we want to move through 
increments of 120 degrees, making a copy, then press Command or Control-d to repeat that transformation. So 
there are some ways in which triangles and diamonds can be incorporated into logos.”
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Stars

	 “-  Stars are such a popular logo element because they signify brightness and excellence. And what com-
pany doesn’t want to be associated with excellence? We can control the number of points on a star, how round 
or sharp their points, we can make them into sunbursts or we can create blunted stars from rectangles. Let’s start 
with the basics of working with stars. The star tool is located on the same tool space as the rectangle tool. If you 
want to draw it from the center point outwards, in this case from the intersection of those guides, hold down 
option or alt.

And if you want it constrained to a horizontal plane hold down the shift key. And if you want to add points to 
your star press your up arrow or your down arrow to remove points. And if you want to effect the second radi-
us hold down the command or control key, this is all while you have your mouse button held down, and pull in 
or out. If you want to reposition the star while you’re drawing it, with the mouse key held down hold down the 
space bar and drag it to a new location.

Once the star has been drawn we’re going to now turn off the guides, let’s zoom in on that point. And I’m going 
to switch from a fill to a stroke ‘cause I want you to see how the stroke joins can effect the star. I’ll come and click 
on the stroke property, I want round corner join in this case. We can also round the edges of the shape by com-
ing to the direct selection tool and we can then pull the targets to the center of the shape.

If you’re working with an earlier version of Illustrator you won’t have that option, in which case you can come 
to the effect menu and stylize round corners. Let’s say that you wanted to use the star as a clipping shape, in this 
case for a piece of type. I will position the type where I want it to go. Now I want the portion of type that overlaps 
the star to be clipped. So I will select the star, copy that, command or control, C, select the letter, paste the star in 
front, command or control, F, hold down the shift key and extend the selection to the letter.

From the object menu I can choose clipping mask, make. If I need to edit the contents of the clipping mask I can 
come to the clip group on the properties panel and I can move it or do whatever else I need to the contents of the 
clipping group. If I want to create a starburst. Here I’m beginning with a 10 pointed star. I’ll choose my line tool. 
I’m going to zoom in and then working with my smart guides I’m going to draw a line from anchor point at the 

top to anchor point at the bottom.
With that line selected double-click on the rotate tool, I will rotate copies through 18 degrees. I’ll press command 
or control, D to repeat that transformation. I now need to delete these portions that go outside of the star shape. 
I’ll select everything, come to my shape builder, hold down my alt key and click on each of those lines to delete 
them. I’ll now set the stroke property to none and come and choose the live paint bucket.

Click on that, I’ll now make it into a live paint group. You see that each of those segments can be colored individ-
ually. I’ll come to the swatches panel and on the swatches panel I have a color group. I’m going to use the orange 
on the left and then the yellow on the right of each of those points on the star. There’s my starburst. I could go 
further with that if I select it, copy it, paste it in front and then we want to rotate it numerically, I want to rotate it 
through 18 degrees, making a copy.

And I’m going to reduce the size of that copy from the center point so I’m holding down option and shift as I 
pull in to reduce the size. Let’s say that we wanted to make a blunt six pointed star. In this case I’m going to start 
with just a rectangle. Double-click on my rotate tool and I will rotate copies through 120 degrees, command or 
control, D to repeat that transformation. Then select all three shapes, come to the pathfinder, combine them into 
one.

For an eight pointed blunt star double-click on the rotate tool, rotate through 45 degrees, repeat the transforma-
tion, select all, combine them all into one. So there we have some very simple ideas for working with stars.
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Polygons

	 “- A multi-sided shape can be drawn with the polygon tool but may begin as a rectangle to which addi-
tional sides are added. Polygon’s can also be created by combining shapes. The polygon may be the logo’s symbol 
itself or may be an enclosing shape that in some way evokes the nature of the business. Here are some polygon 
examples. I’m going to begin with an octagon. Choose my Polygon tool, I want it to be centered on the logo, so 
I’m going to hold down opt or alt, and then click and drag and if I need to add to the number of sides, that’s the 
up arrow, to remove, that’s the down arrow.

To put the polygon on a flat plane, hold down the shift key, and in this case, I do not want it to have a fill. So 
an octagon is the shape of a stop sign so the shape itself carries the message of the logo. In this instance, which 
I realize is not really a polygon, it’s a rectangle, but I’m going to distort this using my direct selection tool, just 
grabbing the bottom right-hand anchor point and then skewing that, so that we emulate the slant of the type. 
And another rectangle that I’m going to distort.

Here I’m going to take this one rectangle and make it one-quarter of it’s current size then duplicate it, holding 
down the opt or alt key, select those two, and duplicate those again. Now we’ll select everything, and I will come 
and choose my free transform tool. I’ll get the free distort tool. Now we can just skew it, like so, to give a sense 
of perspective, and I think I might also want to group it together and maybe make it a little bit smaller and then 
bring it a little bit closer to the top.

Let’s now look at combining shapes. I am going to select the horizontal rectangle here and I want to get the 
top-left and the bottom-right points and move them. So I’m going to start out with the top-left, holding down 
the shift key, I’m going to drag that to the right. I need to make sure I move this one, the equivalent distance to 
the left, so with it selected, I will come to my Move option, transform move, and make sure that that is a minus 
number, like so.

Then we can select both of those, come to the pathfinder panel and combine them into one shape. I’m going to 
add anchor points to this rectangle. I’ll press p, to switch to my pen tool, and I want to add an anchor point at the 
top-center and at the bottom-center, and then I’m going to bring the top one up a bit, and I want the bottom one 
to move down the equivalent distance, then I’m going to select that shape, tap e, to access my free transform tool, 
and use it’s perspective distort options and pull out from the top-left or right.

Now to have the type match that shape, to fill that shape, I’m going to select it and come to Warp, and choose Arc 
warp, and I want to make sure that I get this similar angle on the L and the e, that we’ve established here on the 
side of the polygon. So I think I just want slightly less than that, let’s go with 8%, and I’m now going to just scale 
up the type holding down alt + shift to make it fill that space. I’m going to select both of those and then combine 
them into one shape.

I’ll come and choose my direct selection tool and round the corners, and then I’m going to come and choose my 
perspective tool from free transform, and pull that out from the top-left or right, and actually I can now, just to 
make it not quite so wide so that it surrounds the type, and then I also want to add a curve to the top so I’ll come 
and choose my pen tool, I will tear off my pen tool panel, and come and choose the anchor point tool, and I now 
just want to drag that anchor point up, like so.

In this example, once again, we want to use the free transform perspective option, and I’m going to drag out from 
top-left or right, I’ll come and choose the pen tool, add an anchor point, bottom-center, the anchor point tool, 
and then I can pull that segment up to give it a curve like so. I’m going to drag down a guide just to indicate how 
far that curve needs to go because I want to do the equivalent on the right-side and then I think I’m just going to 
bring the whole thing in a bit to surround the title.
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So I’m going to start out with the top shape and then come to my free transform, perspective distort, I’m going 
to pull this in from the top, and then I’ll choose the bottom shape, e, for my free transform, perspective distort 
once again, and I’m now going to pull this in, until it actually intersects with the lines of the top shape. I can then 
select both, and combine them into a single shape.
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Abstract shapes
	 “- Some businesses lend themselves to certain types of symbolism or can be represented by easily identi-
fied tools or common motifs. For other industries, where the scope of services is broad, a more abstract approach 
might be preferable. Here are some suggestions for introducing abstraction into your logos. Let’s imagine this 
is a well established logo that we want to refresh, while at the same time retain it’s essence. Not unlike Micheal 
Bierut’s reworking of the Saks Fifth Avenue logo.

So, I’m going to take my line tool, and I am going to draw a line dividing it vertically and another line dividing 
it horizontally, and I’ll give both of those lines no stroke. I’ll then select everything, come to the path finder, and 
divide that. So, I’ve now chopped it up into four pieces. What I want to do is select all of the elements of the indi-
vidual pieces and regroup them because the grouping is going to be all off here partly due to the compound paths 
that make some of the characters.

So, I need to start out by ungrouping, and then I want to just swipe over that segment and regroup it. I should 
now be able to pull that away. Alright, good. And then I’m going to do that for each of the segments, so now 
what we do is we rotate these through 90 degrees, and we create some sort of abstract pattern with them that is at 
one in the same time new and refreshing, and instantly recognizable, and then we can copy these tiles and rotate 
them differently.

Let’s actually not do that one. Let’s have that one right there. Something like that. Secondly, I want to use a simple 
shape and just have repetitions of that simple shape to create an abstract shape. Here, we begin with an octagon, 
I’ll come to Effect, Distort and Transform, Transform. I’m going to scale each copy 110 percent. Now, as I do this 
let’s turn on preview so you can see what’s happening here, and I’m going to go at an angle of 80 degrees, and I’m 
going to have three copies.

Of course, I can just come and click into the copies field, press my up arrow, and we can have as many or as few 
copies as we want, but I think three copies is enough to make the point. Here, I’m going to combine shape with 
transparencies, so I have this very simple petal shape, and I’m going to use my rotate tool, Option, alt, click on it’s 
anchor point, and then I’m going to rotate a copy through minus 20 degrees then I’ll press command or control 
D for another copy.

I’ll select all three of those, come to my transparency options, and change the blending mode to multiply. In a 
similar vein, I’m going to rotate copies of this circle from the bottom center point. Press R for the rotate tool, alt 
or option, click on the bottom anchor, let’s use the same angle, copy, and we’ll have three copies like so. I’ll then 
select these, come to my Life Paint Tool, click to make a Life Paint Group, and I can, now, apply color to these 
individual segments.

I’ll come to my swatches panel where I have a color group that I’ve already chosen. I want to use this. I can move 
through the colors in that color group by pressing my left and right arrows. I want to make the stroke on this 
none, so that’s what my logo symbol now looks like. I’ll select it again, and to commit to this, I will expand, and, 
lastly, if we want to introduce an element of randomness we can apply the Tweak effect.
So, here, I’m beginning with star. Let’s turn on the preview, and you can see that we can get some really crazy 
shapes with this. I’m actually going to switch from having a fill to a stroke, and let’s revisit that. I’m going to go 
to the Appearance Panel, revisit the amount of Tweak that I’m applying, and, like I said, it’s pretty random what 
we’re going to get, but now I’m going to expand the appearance, and I’ll make the stroke color none, come to the 
fill and, as I did before, go to my Life Paint Bucket.

’ll use the same color group as I did before, and I’m just going to fill in the different areas with different colors 
in that color group, and I think we need to scale that down a bit, and there is my abstract logo symbol. So, five 
different approaches for incorporating abstraction into your logo designs.
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Geometric patterns

	 “- Here, I’m going to create a simple geometric pattern, and then place that pattern into simple shapes to 
create a bold logo of abstract letter forms. I’ll start by zooming out, Command or Control + Zero. If I just pan 
over to the left, on the paste board, we have the pattern tile that we need to recreate, and to do that, I’m going to 
choose my polygon tool. I’ll hold down the Shift key as I draw my polygon.

If you find that you need to add to the number of sides as you’re drawing, keep your mouse button held down. 
Keep the shift key also held down, and press the up arrow to add sides or the down arrow to remove sides. This 
object has a black stroke, and I’m now going to rotate it by moving to its corner, holding down the Shift key, so 
that it’s pointed sides are at the top and bottom. I’ll double click on the Scale tool and make a copy at 50%.

I’ll now switch to the Line tool and draw lines that connect the edges. First of all, deselect, Command or Control, 
click outside of the selection. Move back over the center point, indicated because I have my Smart Guides turned 
on. Hold down Option or Alt and the Shift key, and draw one line, like so. Double click on the Rotate tool. I want 
to rotate a copy through 60 degrees, and then Command + D to repeat that transformation.

So I now have my basic pattern tile. I want to fill the different segments with colors from my predetermined color 
group, and to do that, I’m going to choose my Live Paint bucket and click to make this into a Live Paint group. I’ll 
come to my Swatches panel and choose the color group that I want to use, starting with the yellow and then I’ll 
just fill in the color segments.

I can now press my right or left arrow to move to a new color swatch with my Live Paint tool. I’ll switch to my 
selection tool, choose the stroke property, and apply none. Now, in order to make this object into a pattern tile, I 
will need to expand it so that it’s no longer a Live Paint object.

I’ll come to my Swatches panel and then drag it over onto the Swatches panel to make it into a pattern tile. Before 
I edit the pattern tile, I’ll click outside of my selection to deselect it, so that I don’t apply the pattern tile back to 
it. I’ll now double click on the swatch, and here I am in the pattern editor. For the tile type, I want hex by row. Let 
me just zoom out so that we can see that more clearly.
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Command or Control + Zero. I’ll leave the pattern editor, and I’m now going to draw my letter shapes to apply 
the pattern to. Let’s just move this over onto the paste board in case we should need it again. I’ll draw down a 
guide. That’s going to indicate the baseline of my type. I’ll press the L key to access the Ellipse tool and draw a 
circle. Option + Shift to draw from the center point of the circle.

I’ll now duplicate that once. Command or Control + D to repeat that transformation. Let’s apply a stroke color 
to them so that we can see where they are. I’ll now select the middle of the circles, which will become the G, and 
I’m going to duplicate this, holding down Option or Alt, and drag away from it, and just create a small amount of 
overlap. I’ll now switch to my Rectangle tool and draw myself a rectangle that will represent the L.

Move that into position. I have my corner widget shown. If you don’t see yours, you can turn it on right here and 
with the corner widget, I can round the corners like so. Possibly adjust the width. I first of all need to select the 
two circles that will make up the G and using my Pathfinder, I will combine those into a single shape. I’ll then 
select all of these shapes and apply my pattern, not to the stroke, as I did then, but rather, to the fill.

Optionally, I can choose to scale the pattern within the shapes if I double click on the scale tool, making sure that 
I do not have transform objects chosen, but only transform patterns, and there, I can choose a different scale for 
the pattern.
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Designing a seal logo

	 “- In this chapter I want to look at common motifs in logo designs beginning with seals. The term seal re-
fers to a wax impression embossed in paper to authenticate a document. And through this historical association, 
a seal logo can convey a sense of trustworthiness and perhaps also a vintage feel. Let’s see how we can recreate 
this simple seal logo. I’ll begin with a circle and I’ll make sure that that has a black fill.

And we’ll start out with no stroke. I’m now going to copy and paste in front, command C, command F, and then 
scale down that copy from the centerpoint holding option or alt and the shift key. I now come and choose my 
type on a path tool. And I’m going to click at the six ‘o clock point on the circle and type in my text. I want that 
text to be centered. That’s going to put it at the 12 ‘o clock position.

I’ll press command A to select all, that’s increased its size. Command shift more than, and because we want a real 
sense of tradition with this, I’m going to use trojan bald. And I’m going to make that 26 points and we want it to 
be white and there’s the type around the top of the circle. So now I want to duplicate that type for the bottom of 
the circle.

Holding down my option or alt key, I’ll pull from this tick that indicates the alignment of the type into the center 
of the circle like so, triple click on the type and of course we have to have a Latin motto here. And I’m going to 
use the trusted Lorem Ipsum. I’ll select that, but scale it down somewhat. Now going to come to my type menu, 
type on a path, type on a path options, I want this aligned to the ascender, now scale it down some more.

I think we want this to be regular as opposed to bald. And I just need to leave enough space between the two 
pieces of type so that we can fit in a star. I think I’m going to make that a little bit bigger. And I want to know 
shift up the base lines so I’ll press command or control T and to my base line shift, and shift that by two points. 
It’s now draw. My guide that indicates the centerpoints. I’ll come back and select the top type.

We’ll make that a bit smaller and I’ll now come and choose my star tool. Draw myself one star right there. And 
hold down option or alt, drag that over to the opposite side. And I didn’t position that very well. Let’s get in a bit 
closer so I can see what I’m doing. Okay. I’ll now select the original circle. Come to my appearance panel and I 
will make the stroke white, we’ll leave it at one point, come to the effect menu, distort and transform, turn on my 
preview, I now want to scale that stroke when I’m estimating 90 percent.

So now I’m going to come and add another stroke. Again we’ll start with one point. I’ll come to effects, trans-
form, this time I’m estimating 60 percent. Let’s turn on the preview. Yeah, that looks about right. And now I 
want a series of stars to go around that stroke. So let’s get the one star that we have, I’ll copy that over outside the 
shape, and I’ll make it quite a lot smaller and come to my brush panel and I’m going to drag that star onto the 
brush panel and make a pattern brush.

I want the spacing on the pattern brush to be 50 percent. I’ll click okay. Now I’ll select my circle, return to the ap-
pearance panel, select the stroke, and then I can apply the pattern brush to that stroke. Now to finish this off, let’s 
just take a look at the finished version. I’m just going to add in some pre-existing symbols that we already have in 
our symbols library. So I’ll come to the symbols panel. You’ll see they’re right there because they’ve been used in 
this document.

But to get these, we come to the regal vector pack. And of course we need some sort of eagle-like bird on a crest. 
So I’m going to drag that out like so. I’m going to break the link to that symbol so that I can edit it and I will 
make it white, drag it into position, and steal it from its centerpoint holding down option or alt and the shift key 
and drop it into the center of our circle like so.
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Next I will add a crown and I may be mixing my metaphors here, but who cares. Drag that onto my artboard I’m 
going to break the link to it and then I’m going to apply a white fill to that. Again we’ll drag it into position and 
we’ll scale it relative to everything else that we’ve got going on. If they just want to make that in a stroke a little bit 
heavier so I’ll select that and we can just bump up the white right there, let’s go for three points.
Okay. There is a seal logo.”
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Designing a shield logo

 A shield harks back to heraldry. It signifies protection and authority. Shield logos are often used for law enforce-
ment and for car companies, as well as for sports teams. I’m going to recreate this shield that we see on the left. I 
will begin with an ellipse. I’ll tap M to go to my rectangle tool, and I’ll draw a rectangle over that. I’ll then select 
both onto my path finder and choose minus front. I’ll adjust the scale.

I’ll come and tear off my pen panel, and then with the anchor point tool, I’m going to click on that bottom an-
chor point, but to reintroduce some curve to it, I will click and drag to the right, holding down the shift key. I’ll 
now click and drag up to add a curve, and I just need to widen that a little bit, I think, so I’m holding down the 
option or alt key to do that from the center point. And now I’m going to make sure that this has no fill, and a 
black stroke.

I’ll get this piece of type, which is on a layer above, and I will move this into position. And to this, I’m going to 
apply an arch warp of 20%. I’ll select the outside shield and then come to the object menu, path, and choose off-
set path. I’m going to offset the path by minus a quarter of an inch to create an interior shape. Let’s get all of these 
items centered.

Okay, there we go. So, I’m just going to move that type down a fraction. Alright, so now, with both of these 
shields selected, I’m going to apply a gradient to their fill. I will use this gold gradient that I got from the gradi-
ents metals group. Keeping them both selected, I’ll then come and choose the gradient tool and change the angle 
of the gradient. I’ll now select just the inner gradient and reverse the direction.

And that’s just going to give me a nice shine across the shield. Now with the inner shield, I want to change its 
shape, and I can’t just scale it, because that’s going to distort the shape too much. I’ll drag down a guide to about 
there, tap C for my scissors tool, and break the path at the point where the guide intersects the shape. I’ll then 
come and delete the top portion, go back to my direct selection tool by pressing A, select those two open end 
points, join them, then with my anchor point tool, I will reintroduce a curve.

Now, to speed things up, a number of these pieces are already made, and they’re on the paste board. So I have 
this pattern here, which is going to go into the interior shield. I’ll select that shield and use my guides to divide 
it into four quadrants. I’ll grab the pattern, move that over into place, and duplicate it, holding option or alt as I 
drag away from it, and then rotate it and position it.

I’m just going to select both of those shields. I’d like to change the stroke weight to two points. These two pieces 
of the pattern selected, I will group them together, command or control + G, select the interior shield, copy it, 
hold down the shift key, select the pattern, paste that in front, then hold down the shift key to reselect the pat-
tern, and make that into a clipping mask. Now, the problem with that is, if I hide the guide, you can see that the 
interior shield now has a variable width, or appears to have a variable width stroke around it.

The way we’re going to get around that is by coming to the layers panel, and I just need to find where that is. It’s 
on layer one, actually. That one right there. I’m going to select it, and then I’m going to align the stroke to the 
outside. Now, we can turn that clipping group back on, and the problem is solved. So I’m now going to add in 
these keys. These are a Photoshop custom shape, nothing more than that.

In a blank Photoshop document, I just drew these onto my canvas and then copied and pasted them individu-
ally so they don’t come in as one single compound path. Copy, paste, compound shape. Then we can apply a fill 
to them. But we already have them here, so I’m just going to use the ones that we have, and I’ll scale those, and 
rotate them as necessary. Now I want another interior shield shape.
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This time, for variety, I’m going to create that or modify an existing symbol. I’ll come to the maps symbols. I’ll 
use this interstate highway symbol. I’ll break the link to it, scale it up, ungroup it, delete the bit that we don’t 
want, come and delete that anchor point, convert the top two anchor points so that we have a straight edge at the 
top, which just happens to be what I want in this case.

I’ll now drag that over into position. Using the eyedropper tool, I’ll sample the fill and stroke of the outer shield, 
and I am going to come to the appearance panel. I think I want to make the stroke one point. I do want to move 
it inside the shield’s shape. So, from transform, I’m going to make the scale of that stroke. Let’s try 96%. How 
does that look? No, let’s go to 93%.

Okay, I can do the same with this one. I’ll try just applying the same percentages as I did, and that’s a little bit too 
much in this case, so I’ll revisit that transformation and this time, I will use a 96%. And then just to finish the 
whole thing off, by all the tweaking, I’m going to add in one more symbol, and this is going to come from the 
regal vector pack. I want to use this one, number nine.

Again, I need to break the link to it. I’m going to come to my reflect tool and reflect it across the vertical axis. Just 
seems to look better facing the other way. And then I’ll scale that down, position it, and I have a piece of type 
over here on the paste board, on a layer above. I’ll just drag that into position like so. I said on a layer above, but 
it seems to be behind, so I need to just bring that to the front.

And there we have our shield. Slightly different shape, second time around, but all the essential ingredients there. 
I’m not sure what all these mixed symbols add up to meaning, but hopefully some of the techniques were useful.
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Designing a ribbon logo

	 “- So, let’s re-create this ribbon, starting with this type in a red rectangle. I have a guide marking the 
center point of that rectangle. With my Rectangle Tool, I’m going to draw another rectangle over the bottom-left 
corner, switch to my Eyedropper, and pick up the properties of the larger rectangle. I’m then going to change the 
alignment of the stroke to the inside, which is the same as the larger rectangle. Let’s now move this behind the 
bigger rectangle, and I want to move it a little bit to the left as well.

Now I’ll switch to my Pen Tool. Selecting the larger rectangle, and then choosing my Draw Behind mode, I’m 
going to draw a triangle down here that will simulate the shadow. And I’m doing it behind just so that we make 
sure that it’s a completely seamless join. I’m holding down the Shift key as I do this, except for that last stroke 
there, and then I’ll make that into a filled path. I want to switch the Fill and Stroke properties so that it’s filled 
with black and then make sure that it has no stroke.

Now I’m going to come to add in an anchor point right there, and I will drag that inside, like so. I’ll then select 
those two elements that make up the back of the ribbon, group them together, come to my Reflect Tool, and we’ll 
reflect them across this guide, Alt or Option, click on the guide. We are reflecting across the vertical axis and 
making a copy. Now I’m going to select everything, come to the Effect menu, and choose Warp, Arch.

So when I choose Arch, I find that it doesn’t work, or rather, it’s arching each of the individual elements. So I 
need to cancel that and first of all group everything together, then I can come and apply my Arch effect, and I get 
the result I’m after. Incidentally, just a footnote to this, let me point out that we do have ribbons available in our 
Illuminate Ribbons symbol set. And you can adapt these to your needs, just drag them out onto the pasteboard, 
break the link to them, and then you can work with them as you need to.

But I think it’s always preferable to create these pieces yourself, and that way you have a sense of ownership of 
them.”
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Designing with swirls and swooshes

	 “- Swooshes, swirls, organic ribbons. Whatever you want to call them, they can add a sense of playful-
ness, dimension, and movement to a logo. They might be entirely abstract or evoke the business of the company. 
So here are three examples of said swooshes, swirls, or organic ribbons. I’m going to choose my brush tool. Come 
to my brush panel, and I’m down to Wacom 6D brushes, and let’s begin with that one, the 27 Art Pen brush, and 
now, I need to just experiment with this.

Let’s see how that goes. It’ll take a few goes to get just the right sort of stroke. All right, let’s say I like that one. I 
can select it. Maybe I’ll come to the brushes panel, and perhaps change the angle a little bit. I am going to reduce 
the roundness. Let’s experiment with the shape of the brush a bit. All right. I like that. So I’m going to apply those 
changes to the strokes. I will outline the stroke so that it’s now a fill.

Let me just delete this one on the top here so I’ve got a bit of room to work with. And now, to contain it, just so 
that we tidy up the ends. I’m going to draw a rectangle around it. I’m going to make sure that rectangle has no 
fill and no stroke. I’ll select it and the shape and then we’ll make that into a clipping mask. Secondly I’m going to 
come to my brushes panel and to my artistic calligraphic brushes and use a 30 point flat brush.

And then just experiment with some strokes. When I get one that I like, and then just going to duplicate it a cou-
ple of times. Outline the stroke, and then I’m going to apply a gradient to that. Let’s change the direction of the 
gradient. And now, with my direct selection tool, I’m going to click in each one and change the direction of the 
gradient individually. And then to finish that up, I’ll just group those together and there’s my symbol.

So for my third example, I want to create an organic ribbon like this. And I’m going to do this using the 30 point 
flat brush or at least starting with that. I’ll experiment by making some strokes. That one looks like it might be 
okay. Let’s see if I can get any better. All right, let’s go with that one. Let’s just come to my brush options. I will 
increase the size of that just a bit. I’m going to take down the roundness down to zero.

Apply that to the strokes. Now I’m going to outline that stroke. It’s going to make it into a filled shape. Using my 
shape builder, I want to join these two pieces at the front, and have the piece at the back be separate. Now I can’t 
do that at the moment because this shape is just not working for me. So I need to come and make some adjust-
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ments. You may or may not need to do this. More depends on your initial brush stroke.

I’m going to do that, and then I’m going to get that anchor point there and bring that down a fraction. Let’s now 
try that again. I’ll swipe over that shape builder tool, and I can join those segments together. And we can have 
the reverse side as another segment. So let’s just now apply some colors to these. I’m going to select that bit, and 
apply a gradient to that. And then select the front piece, and we’ll have a solid color applied to that.

And then, let’s just come and select the reverse piece and I’ll use my gradient tool and just adjust the angle of that 
gradient. I need to work on the angle of that gradient a bit more. Yeah, that’s better. So there we see three differ-
ent approaches to creating swooshes or organic ribbons.
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Designing with hearths

	 “- A symbol of love, of health, and of life itself, it’s no surprise that the heart is such a popular logo sym-
bol. Here I’m going to deconstruct two very effective heart logos. Habitat on the left, and Wahl’s ice cream on the 
right. Let’s move down here and I’m going to start by creating a heart. I’m going to start with, well let’s start with 
a circle. And then, I’ll tear off my pen tools and with my anchor point tool, click on that bottom anchor point, 
and then with my direct selection tool on the top anchor point, I’m going to bring that down, and now I want to 
pull up this side, but when I do so, that’s going to happen, so I need to hold down the alt key as I do that.

I’m also going to hold down the shift key to constrain it. I’m going to pull down a guide to that point because I 
want to make sure that this side comes up exactly the same and this time I don’t need the alt key, just the shift 
key. And I could then adjust that as necessary. Maybe you want to pull that down a little bit more. Perhaps it’s just 
a little bit too plump, so I’ll just reduce its width. Holding down the option or alt key as I do so.

Now, let’s just remind ourselves where we’re going. We want to create something like this. So I’m going to in-
crease the stroke weight, and then let’s draw a rectangle around that, and it’s a fantastic association of heart and 
home here. So I’m going to make an anchor point on that path, bring that up like so, and now with my scissors 
tool, I’ll come and cut the path on the heart.

Let’s zoom in down there. You can see that path has been cut. I also want to delete the bottom segment of the 
house. So now let’s grab that half segment right there, and drag that onto that open anchor point. I’ll swipe over 
those. I’m in my direct selection tool. And then join them. And I’ll do the same thing over here, onto the anchor 
point, swipe over them, and join them.

Okay, let’s change the shape of my heart. It’s in a somewhat undesirable way. So I’m going to select that anchor 
point and drag that down a bit, holding down the shift key as I do so. I’ll pull down a guide just to indicate how 
far that handle came down, and then do the same on that side. Now I will switch to my ellipse tool, and I’m going 
to draw myself an ellipse, or rather a circle, in there.

I want it to match up as much as I can, with that stroke. I’ll now duplicate that like so. I’ll select these two pieces. 
Let’s give them no fill. I’ll come and choose my shape builder, and now remove the bits that we don’t want, so that 
we’re left with just with that. So now, just to finalize that, I’ll select it all. Let’s make sure it’s positioned in exactly 
the right place, which is there.

And then to finalize that, swipe over it, and group it together. In this example, I’m going to begin with a heart. 
Let’s increase the stroke weight on that. And now I’m going to copy that, paste it in front, and scale down the 
copy. I’ll come to my scissors tool and break the path on the large heart and delete that segment.

Then go back to my scissors tool, break the smaller heart at the bottom, and now I want to separate these two. 
Let’s drag that over like so. Let’s move that one back up a bit. So these two anchor points here, I want those to be 
joined. Actually, that’s going to distort it if I do it like that, so let me make sure I pull that one exactly onto there, 
like so. Swipe over with my direct selection tool, and I want to join them, but I can’t because it thinks, for some 
reason, that these are not two open end points.

So I’m going to use a stealth tactic here. I’m going to switch to my outline mode. I’ll move that anchor point 
away, and rather than swipe over them, which for some reason doesn’t seem to work, if I select one and hold 

down the shift key and select the other, it does seem to work. Can’t really explain why, but I’m just going to go 
with it. I’ll come to object path and now I will average them across both axis’, and now I can join them. So I’ll 
now go back to my preview view mode, and to give this some character, I’m going to come to my width tool, and 
pinch it in at the start and the end.

And then possibly just increase the weight of the whole stroke.
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Designing with nature-inspired

	 “- Nature is a deep and rich vein of logo symbolism. Trees, plants, flowers and leaves, the sun and the 
landscape. Nature inspired imagery has connotations of fertility, the seasons, growth, and renewal. Here are four 
approaches to creating a nature-inspired logo based on a leaf. So in the first example, I’m tracing over a leaf and 
creating a relatively, relative being the operative word, naturalistic leaf.

Then I’m switching to a completely geometric leaf and then that suggests simplifying further just using the leaf 
shape, creating some sort of interaction between a repetition of that leaf. And then finally, switching to a differ-
ent kind of leaf and experimenting with the negative space that is created between the two leaves. But let’s start 
out with this first version. I’ll come to the layers panel and I’m going to turn off the finished layer, turn on the 
image layer.

I’ll also turn off the type layer. Tearing off my pen tools, and starting with my pen tool, I will create a very simple 
outline based on straight line segments around the leaf. I then come to my anchor point tool and apply some 
rounding to those anchor points. Now I will come to my pencil tool and add in the veins of the leaf. As I do this, 
I want to make sure that this option with the pencil is unchecked at its selected paths.

And I’m deliberately continuing these outside of the leaf shape. Now let’s select all of those elements and apply a 
variable width profile to them. I’ll come and change the color to the dark green color. On my swatches panel I’ll 
select the major veins and increase the white. I can now turn off the image, select the outline, and make its stroke 
none, make its fill the lighter green color and then from the effect menu, come and apply an inner glow which 
uses the darker green color.

Now let me select everything, deselect the outline, and group all of the veins of the leaf by pressing command 
or control G. I now want to select the outline shape and copy that, command C, select the veins, command or 
control F to paste the shape in front of that, extend the selection to the veins by holding down shift and clicking 
on them, and then make that into a clipping mask. Let me go back to my pencil tool now.

I’ll just add in stroke right there, it’s going to be a two point stroke, let’s make it the variable width. Going to 
come to my width tool and make that wider at the bottom and a bit wider at the top too. I’ll now group all of that 
together. Let’s turn the type back on. I’ll come and apply a twist effect to that and scale it down into place. Now, 
am I crazy about that? No it’s alright but it’s not going to win any awards.

It’s too complicated. So that process then leads me to thinking well, if we’re going to work with the leaf, let’s work 
with a further simplified version of the leaf. I opened up the original image in Photoshop. I straightened it and I 
masked half of it. Bringing that back to Illustrator, I then manually traced that half in the same way as I did the 
first example, that gives me a half like so, and then from there I use my reflection tool, reflect a copy, join those 
two pieces together, and then I’ll copy that because I’m going to use that as a clipping shape as well in just a mo-
ment.

I drew the veins of the leaf again in a completely symmetrical way this time. I’ll paste that clipping shape on top 
of those, select those as well, and once again make a clipping mask. I’ve only made the veins yellow just so that 
we can see them. I’ll now select them and they will become white. So that was my thinking in that example. And 
if we just look at the finished version, there is the leaf juxtaposed with the type. That led me to simplify further so 
that we have just the shape, no veins, just nothing more than a leaf shape, and what if we were to duplicate that 
shape and then spin it around, adjust its position, and then change its blending mode to multiply.

And then jumping off from there, how about we just experiment with a different leaf shape entirely. This is a 
Photoshop custom shape filled with a gradient and then when I reflected it and adjusted the position, unexpect-
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edly but somewhat fortuitously I think the negative space that is created between the two is interesting. To me it 
looks like a candle. And maybe there’s something there that I can work with. So those are my four variants on a 
leaf-inspired logo.
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Designing with architecture-inspired imagery

	 “- Maybe you’re designing a logo for an architecture-related company or maybe you’re designing a logo 
for an actual building, or maybe the company is strongly associated with a city known for a particular building 
or monument. Buildings can be a great source of logo inspiration. They might be literal or metaphorical, realistic 
or highly abstracted. I’m going to run through my attempt to create a logo for the De La Warr Pavilion, a fantas-
tic modernist building located Bexhill-on-Sea on England South Coast.

For my first attempt, I placed a source image and I image-traced it and then simplified it as much as I could. 
Here is my source image, here it is in Photoshop, and I’ve used every trick I know to make this source image as 
crisp and as simple as possible. You can see that I’ve masked out any unnecessary detail. I’ve applied an excessive 
amount of sharpening, not that that improves the appearance of the photographic image but it will improve how 
it responds to tracing.

I’ve made it black and white, and I’ve increased the contrast. So when I trace this in Illustrator, that’s the sort of 
result that I get. It’s then a question of evaluating my tracing results, turning on Ignore White, taking down the 
noise, and then expanding the result and further cleaning this up. Requires a lot more cleanup. So I’m going to 
hide my edges and then come and choose my eraser tool to start with.

Just get rid of the stuff that we can easily remove. But I’m not gonna spend too long on this because even though 
it’s getting simpler and I could invest more time to make it simpler, still it’s far too complicated. But this was 
informative. Doing this has made me focus on what are the essential elements of this. If we look at the Layers 
panel, we can see that I’ve gone through various iterations trying to distill it further, every time simplifying it a 
bit more than the last.

I’ve dispensed with the image tracing and now I’m just manually tracing using the pen tool to create solid objects 
and filling them. So I ended up with something like this. Still a work in progress but I think that this has some 
potential. I got there by manually tracing over the same source image a number of field shapes.

Now I’m going to use my Live Paint to fill them with color. So I’ll start out by selecting this and before I go any 
further, I want to make sure that everything has a white fill and no stroke. Then I’ll come and choose my Live 
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Paint bucket and click to make a Live Paint group. It’s now time to turn back on my Show Edges. On my Swatch-
es panel, I have a color group.

I’m gonna start out by filling in the black areas. Now, of course, it helps to have the source image near at hand 
when you’re doing this. So let me just back out for a moment and... I’ll turn the manual trace layer on and then 
just move it to the side. So now back with my Live Paint group. Let’s hide those layers. I’m really working on the 
interplay of the positive and negative space here, and where the railings overlap the lighter parts of the building 
and the sky then they become positive.

So there is some back and forth here and you’re bound to go wrong at some points as I am doing, but the nice 
thing about Live Paint, or one of the nice things about Live Paint, is that you can always go back and change your 
mind. Let’s just see how I’m doing with that. You can see that it’s very much a work in progress. Some things 
about this need to be fixed. Let’s just go back and see where I was with the earlier version, but the essential point 
here is that through working with iterations of this, I’ve been able to really focus on what I think is the essence of 
the building and simplify it down to just the really essential parts.
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Designing with animal-inspired imagery

	 “- Working with animal imagery, you could make an analogy between company’s values and the per-
ceived qualities of the animal concerned. Be those qualities; strength, speed, cuteness, cunning, loyalty, or grace. 
I’ve created an animal logo starting with a rough sketch. Because drawing is not my strength I’m choosing to cre-
ate a very abstracted dog. I’m going to reinterpret this as I go, with the pen tool just creating a very rough shape, 
let’s make sure that it has no fill.

Starting out with straight line segments only. And then with my anchor point tool introducing some curves. So 
I’ll now fast forward to this point. That’s what I came up with and then we can now hide the original image layer. 
And then I went from this to make it into a logo. And I chose the name fido, it seemed like an obvious choice.

And I broke the letters apart and I got attached to the idea of taking the dot on the eye and making that into the 
eye of the dog. And then it occurred to me that the I looked like a bone so I decided to put the bone in the dogs 
mouth. And I’ve just given the outline of the dog a white stroke so that we can see the definition of the dog head 
shape around the bone that’s in his mouth. Have a go at creating your own animal inspired logo starting with a 
reference image and a sketch.
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Taking inspiration from patterns

	 “-  Here are examples of how to take logo design inspiration from images as wide ranging as cracks in the 
pavement, tidal patterns on the beach, and ridge patterns in a sand dune. Firstly, the cracks in the pavement. So 
what I’m going to do here is I’m going to get this image and I’ll make a copy of it over here. I’ll hold down the 
Option or Alt key and the Shift key and just drag that over. And I’m going to lock that Command or Control two.

I’ll choose my Rectangle tool and hold down the Shift key and I’ll draw a square on top of that. I’ll make sure that 
the square has a stroke but no fill. So I just switched the values that I formerly had so I now have a white stroke 
and no fill. I’ll use my Line tool and then just very roughly replicate the pattern of the cracks.

Okay I think that’s probably enough right there. I’ll also press the L key to access my Lips tool and let’s throw in a 
couple of circles. One there and one there. I want the circles to be white, so I’ll press Shift + X to switch to having 
a filled circle rather than a stroked circle. Let’s select these lines and increase the white of those.

I’m going to go up to six points. I’ll extend my selection to the circles, group them all together, and then I’ll select 
my bounding rectangle, change its stroke to none and it’s fill to black. I will select the rectangle, copy it, Com-
mand or Control + C. Now come and select one of the shapes of the group, Command or Control + F to paste 
that copy in front of the group.

Hold down the Shift key and select the group along with the rectangle that is at the top. Command or Control + 
seven, to make that into a clipping mask. And then I will just come and Unlock All, so that I can now delete the 
picture that served as my inspiration. And there is my logo. Now my second example. I like this picture of tidal 
patterns on a beach.

And I want to create some sort of representation of this that I can use as my logo. So I’m going to draw a circle. 
My circle is actually going to be at a specific size and that size is 125 points. I’m now going to go to the Effect 
menu and to Distort and Transform, Zig Zag. I want this to be Relative. And I am going to have a size of six per-
cent and I want 10 ridges per segment.

And I want them to be smooth. Turn on Preview. And that’s what I’m going to get. Now coming to my Appear-
ance panel, I’m going to duplicate this item. Before I do that, I need to drag the Zig Zag effect into the fill. So I’m 
going to drag that down, like so. Then I’ll select the fill and I will duplicate the item. Now with the version that is 
on top I will change its color to white and I’m going to Transform it to 80% of it’s current size.

I’m now going to repeat that. I’ll select the white and I will duplicate it. Working with the version that is at the 
top, I will change its color to the gray. And I’m going to revisit the Transformation and change its Scale to 65%. 
Let’s do that once again. Selecting the item on top. Duplicate the item.

I’m going to change the color to white. I will revisit the Zig Zag effect by clicking on that. And in this case I want 
to reduce the percentage to one. And I also want to revisit the Transformation and I’m going to reduce the size to 
60%. I’ll make one more copy. Duplicate the item.

With the version that is on top, I’m going to change the color to black. And I am going to leave the Zig Zag as is, 
but come to the transformation, where I’m going to transform it to 55%. Now remember all of these scales are 
relative to the initial shape. And I’m also going to offset in this case. I’m going to offset it by 8 points horizontally.

Let’s turn on the Preview. And that’s what we’re going to get. So now I’m going to add a rotation to all of this. I’m 
going to come and click at the top of the Appearance panel to select the whole path. Come to Effect, and choose 
3D Rotate. And I’m going to use the following values for my X, Y, and Z axes. Minus 134, for the X.

Minus 40, for the Y. And 37, for the Z. And then turn on my Preview. And that’s the result of the rotation ap-
plied. Now I want to switch to my Rectangle tool. I’m going to draw myself a rectangle over just this left-hand 
portion. I think I want to crop it to about there. With my Shift key, I’ll extend the selection to the object behind 
and I’ll press Command or Control + seven, to make that into a clipping mask.

I actually want to put a black stroke around the clipping mask, so I’m going to come to the Layers panel and I 
will expand my Layers panel so that I can select just that top clipping shape. I’ll come to its Stroke property and 
make that black. Let’s go with two point. And I will also just pull it down from the top somewhat. So there is my 
second version.

This one inspired by the tidal pattern. For my third version, I’m going to use this picture of a sand dune and I’m 
going to use Image Trace to trace the sand dune and then modify the Image Trace. So I’ll select the image, in fact, 
first of all I’ll copy the image by holding down Option and dragging away from it. And then I will click on Image 
Trace. Click OK to move through that warning message.

So now I’m going to come to my Tracing options. I am going to put the noise all the way up to 100 pixels so 
that we do not trace some of the fine detail. I want to simplify things here. And I’m also going to choose Ignore 
White. With those two adjustments made to my Tracing options, I will expand the result.

Zoom in on the result. I need to hide the edges so that I can see what I’m working with here. And then I’m going 
to go to the Object menu and choose Path, Simplify. I’ll turn on my Preview. I want to simplify this at a percent-
age of 97% Curve Precision. And when I do that, we can see we start out with this many points, 9,718, and we 
end up with 3,240.

So I’m going to click OK to that. And then, I actually want to take just a portion of this because I feel like the 
foreground is still too detailed. So with my Rectangle tool, I’m going to draw a square over the portion that I like 
and then I will select both the square and the traced image. I realized I still have my edges hidden, I’m now going 
to show them. I’ll come to my Pathfinder panel.

And I will crop that. So that that is what we are left with. That is going to serve as the symbol for my logo. I might 
just want to come in with my Eraser tool and erase any distracting small details. So they’re three quite different 
approaches, but what they all have in common is that they are all suggested from a photograph.
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Creating shine

	 “- Advances in our software make it easier to apply dimensional effects like shines, glosses, and bevels to 
our logos. And adding such effects can be a great way of refreshing an existing brand, and bringing a logo up-
to-date. But we need to be careful that we don’t introduce bitmap elements that are resolution dependent. In this 
chapter, I’m going to look at adding some popular effects, all of which will be completely scalable. Let’s create a 
simple shine in the corner of our enclosing shape.

I’ll start by rounding the corners. I’ll then come and apply a warping effect, inflate by 10 percent. I will then copy 
that shape, paste that shape in front, so that’s CMD or CTRL + C, CMD or CTRL + F. I’ll scale the copy from the 
center point holding down the OPT or ALT key, and then I will apply a gradient to that. Now I will come and get 
my gradient panel, which has gone missing in action, so I’ll come choose it from the “Window” menu.

I want my gradient to be a white-to-white gradient, so I’ll select the currently black gradient stop, hold down 
OPT or ALT and click on “white,” and then I want to reduce its opacity to zero. I’ll now choose my gradient tool 
and I’ll just pull down from that top corner to determine how much of the gradient we see. And I might need to 
take a few go’s at getting that just right, but that, essentially, is the technique.”
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Creating gloss 

	 “- Let’s recreate this gloss effect that we see on the left. I’ll start by selecting my red circle, I’ll copy it, 
and then press command or control b to paste that copy in back. Holding down option or alt and the shift key, 
I’ll scale that copy, and then I’ll come and apply a chrome gradient to it. That chrome gradient comes from the 
gradients metals swatches. Right now I have one of those, I will copy that chrome gradient, paste it in back, com-
mand or control b, and scale it up again.

On the gradient that is in back, the one I have selected, I will change the direction of the gradient using the gra-
dient panel. I’ll now come and select the red circle from the effect menu, I’ll come to stylize, inner glow, change 
my color to black, let’s turn on my preview, I want to use a blend mode of multiply, and then I can adjust the blur 
as necessary. I’ll now copy that red circle, paste it in front, command or control f, and scale it.

Now on the copy that I’ve just made, I do not want that in a glow so I will come to the appearance panel where I 
can remove it. Keeping that inner circle selected, I will come and apply a gradient to it, I have one already made. 
If we take a look on the gradient panel, we can see it’s a white to transparent gradient. I am going to end up 
changing the direction of the gradients so I won’t even bother doing that yet. My next move is to create an arc.

I’m going to create an arc that swipes across the artwork like so. I’ll be using this arc twice so I’m going to copy it 
before I do the next step which is to select it and both of the chrome circles behind it. Then using my pathfinder 
panel, I will use the divide option. That’s going to group those two elements, now four elements and bring them 
to the front. I want to select the bottom portion of the back gradient and reverse its direction, and then I want to 
do the same with the inner circle.

I’ll now leave isolation mode. I can select the chrome circles and send them to the back, command shift, left 
square bracket. I’ll select the inner circle, the one that has the gradient, and in front of that I will paste that arc 
that is on the paste board, command or control f. Holding down the shift key, I will select circle and arc together, 
now return to my pathfinder, and divide. I’ll press a to access my direct selection tool, deselect, then reselect the 
bottom portion of that now divided circle, and delete it.
I’ll select this circle or what remains of this circle and then adjust the angle of the gradient on that and it’s prob-
ably going to take me a few goes to get that right. Okay, I’ll go with it like that and then come and change its 
transparency to screen. Optionally, reduce the percentage of the opacity.
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Creating a bevel effect
	 “- Let’s create this 3D bevel effect. I’m going to come to the Layers panel, I’m going to turn off the type 
layer, and the finish layer, and come to the start layer. The start layer is the shape of the wings. To create this, I 
traced half of it, and then reflected it, joined the two together, and we have applied to this a steel radial gradient. 
The gradients I’ll be using come from the Gradients, Metals, Swatches.

I’ll start out with my line segment tool, and I’m going to draw a line like so. To this, I’m going to apply a 10 point 
stroke, and I want the stroke color to be a 30 percent gray. I’m then going to apply a variable width profile to it, 
width profile number four. Let’s zoom in on that, and see what we have. I want the width profile direction to 
change. Can’t do that right there, but if I come to my Stroke panel, I can do it there.

And I also want to edit that width profile, so I’m going to come to my width tool, and make it a little wider as it 
reaches the center. Now, just before I go any further, let me say a word or two about the background. We’re going 
to have three copies of this background. There’s the one we’re looking at, that will provide the background radial 
gradient. There’s one that will become part of the whole structure of the whole pattern, and there’s a third one 
that’s going to go on top, that will be a clipping mask.

For now, I’m going to come to my Layers panel, and drill down to my start layer, the contents of my start layer. 
I’m going to lock the background shape that we have. I’ll press R, to access my rotate tool, and then Alt-click on 
that anchor point. I want to rotate copies of that spoke through minus eight degrees. Having got one, I’ll press 
Command or Control-D, until we bring it to the center.

I’ll then press Command or Control-A, since I only have the one layer visible, I’m only selecting content on this 
layer, and I’m now going to reflect that across the vertical axis, making a copy. I will then select all of that, and we 
will group that together. Let’s now come to our background. I’ll select the background, and I’m going to copy it, 
and paste in front.

On the copy that is in front, I’ll give it an eight point stroke, and no fill. I’ll come back, and lock the original 
background. Now, I’m going to create an ellipse drawn from the center point, like so. This should have no fill, 
and the same gray eight point stroke. I’ll press C, to access my scissors tool, and I’m going to break the ellipse 
there, and the equivalent point on the other side, and delete the top portion.

Now switch to the pen tool, come and pick up that open path, and connect that to the outside shape. As I do so, 
I’m going to click and drag, and I didn’t quite get that right, I’m going to have to come and move that down in 
a minute, but I’ll do the same on the other side. First of all, deselect the stroke, click on the open end point, and 
then click and drag. Let’s just zoom in on this one. Select it with the direct selection tool. I’m now just going to 
nudge it down.

Also with the direct selection tool, I’ll pull down that center point, and possibly just adjust the nature of that 
curve, like so. So I’m now ready to select all, and from the Object menu, come to the Path option, and outline the 
stroke, turning all of those strokes into fills, and then come to the Pathfinder panel, and uniting them all as one.

The next thing I want to do is clip all of the pieces of the art that go outside the wing shape. So I’ll come to the 
Layers panel, we have this version that is locked. I’m going to select that, copy it, select what is now my com-
pound path, and paste in front of that, Command or Control-F. Now, on the copy that I’ve pasted in front, this 
is going to become the clipping mask shape, but I need to first of all, let’s set its fill to the 30 percent gray, and its 
stroke to the 30 percent gray as well, and we need to have an eight point stroke.

And I now want to expand that, so that it’s just one shape that is the size of the artwork that we want to clip, and 
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one more step before I can make it into a clipping mask, and that is to unite the, what was formerly the fill and 
the stroke together, now on my Layers panel, I can extend the selection to the compound path beneath, by hold-
ing down the Shift key, and come to Clipping Mask, Make.

Now, to add the bevel effect to the contents of that clipping group. So I’m going to come and click on Edit Con-
tents. And then to my Effect menu, 3D, Extrude, and Bevel. Essentially, I want the position to be front, but I do 
need to add just a little bit of angle to it, so that we can really see the effect that we’re applying. If I now turn on 
the preview, you can see, we’re not really seeing much of an effect, and won’t until we just adjust this.

So I’m going to adjust the x-axis, I’m actually going to do it numerically, so that I can get the same as I did before. 
I’m going to go for minus five. And then, I’m going to change the perspective so that it’s not entirely uniform, I’m 
going to change the perspective to 60, and, unfortunately, the preview at this point may let me down, and in fact, 
it has, but I know that from doing this previously, I want to reduce the number of blend steps, because I don’t 
want to end up with something that’s too complicated.

I’ll reduce that down to three, and then I’m going to change the lighting direction to be head on, like so. And 
things now do restore to something like normal. So when I click OK, let’s keep it selected, but press Command 
or Control-H, to just hide the selection edges. So there we see the bevel effect, and I’ve deliberately made it as 
simple as possible, by reducing the number of blend steps. So I now want to add a gradient to my artwork.

I didn’t want to apply the bevel effect to the artwork that had the gradient, because it would have rasterized 
the gradient, so my workaround is this. I’m going to expand that clipping group. I just want the contents of the 
clipping group selected, Command or Control-C, Command or Control-F. I’m now going to apply the gradient 
to that. Just before I do, though, let’s remove the extrude and bevel effect from the copy, and then I’ll come and 
apply the chrome gradient to that, and I’m going to change the blending mode to Overlay.

I’ll press Command or Control-H to hide my edges. Now, I could go one step further here, and divide this, so 
that we get more of a reflection, and I think I’ll do that. So I am going to go back to my layers. I find it useful to 
work with the layers here, when we’ve got some relatively complex artwork going on. I’ll turn my edges back on. 
I’m going to lock that one. I just want this one here.

I’m also going to lock the clipping mask. I’ll choose my Line tool, and just draw a line there, and then, let’s move 
that line down, so with the line and the artwork that has the gradient applied to it, I’m now going to divide that. 
And that’s going to allow me to select just that half, and I’ve double-clicked on that to get to my isolation mode, 
and then reverse the direction on the gradient.

Now, let’s leave isolation mode. I’ll come back to my layers, and I’ll turn my type layer on, and there we have our 
finished version.
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Working with transparency

	 “- By the careful overlapping of transparent design elements, we can create more colors, more shapes, 
and more meaning. You can use transparency in a conceptual way to convey the nature of the the business or its 
values. Here are two approaches to working with transparency. I’m going to start with type. Press Command or 
Control+T to bring up my Character panel, and then come to my Touch Type tool. I want to rotate and overlap 
these letters. I’ll convert the Type to outlines and Ungroup.

One by one, select the letters and apply colors to them. Select all four letters under the Transparency panel, and 
choose Multiply. Now actually I’m going to go a step further than that. Because I don’t want to rely upon a blend-
ing mode to achieve these colors. It’s going to be unpredictable, and I also want a bit more control over what 
colors I’m getting in the areas of overlap. So I’m going to duplicate that, just holding down Option or Alt and 
dragging away from it, and I’ll rasterize the copy.

Back to my Swatches panel, I’ll now use my Eyedropper tool to sample those overlapped colors. I’ll add them to 
my Swatches panel as global colors, which I can then edit. I can now delete that rasterized copy. On my outlined 
letters I’ll restore the blending mode to normal. And then come and get my Live Paint bucket. I’ll come and 
choose these colors, click to make a Live Paint group, and apply these colors in those overlap areas.

Now, the reason I’ve made it Live Paint is because it’s live. So if I decide I need to move these letters around, 
you’ll see that the interaction remains in place. I realize that these colors are not quite what I want, so I can now 
come and edit them. And let’s say I want something like that. Let’s turn on my preview and you can see that, 
that’s going to update in place. So that was the Touch Type tool, creating outlines, ungrouping, applying the col-
ors, experimenting with the Multiply Blend Mode, but not actually going there, segmenting the letters using Live 
Paint, and then filling in the different segments with separate colors.

Now let’s come to this example. I’m just going to move over to the left and look at the finished version. This is 
where we’re going with this. And as before, I don’t to want to use transparency for the same reason but rather 
apply separate colors to the overlapping segments. So I’ll select those three overlapping circles, come and get my 
Live Paint, and I’m now going to use this color group. Click to make a Live Paint group. So we want the red to 
actually go there, and the blue to go there, and the green will go there.

And then in the middle, we want it to be black. But we also want a heart to replace that inner segment. In order 
for this to work, I need to spin this through 180 degrees. And I’m now going to just come to my Symbols panel 
where I have a heart already. This heart comes from the Web Icons. There it is, so I could just drag that out right 
there. I can break the link to it with my Direct Selection tool.

I can delete the inner shape, and there I have my heart. I’ll now just put that into position, and scale it according-
ly.”
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Designing with negative space

	 “-  Negative space refers to the white space or paper color that shows through a design. What we see on 
screen is from the Wikipedia entry on negative space. It’s a visual conundrum. Is it two people in profile or is it 
a vase? Using negative space to imply a shape, reversed out of a background can be a great way to add a twist to 
your logo. Negative space can be hard to deploy, but if you can pull it off, it really adds something. It also pro-
vides an ah-ha moment for viewers, when they realize what the negative space connotes.

Here are some ways we can work with negative space. So, I’d like to create this monogram. And I’m going to 
position the G and the T relative to each other. I want the G to go behind the T, so I’ll send that to the back. And 
then I’ll select the F. I’ll start out by making that white. Ultimately, it needs to be transparent but just while we’re 
positioning it, I’ll make it white and then scale it into position. The type has already been converted to outlines.

And in this particular case I just want to nudge it a bit to the left so that it’s covering that space. And I think 
make it a little bit more noticeable as an F, a little bit more distinct as an F by moving this crossbar down a frac-
tion. So I’ll select those anchor points and then use my down arrow to nudge that down. I also, now need to just 
bring those anchor points out.

So that they align with the right edge of the T. Okay, so having done that, I’ll now select everything. Come to my 
shape builder tool and I’m going to hold down the Option or Alt key and delete the segments that make up the 
F. And the reason for that is that, if we are placing this on a field of color, that that area represented by the F is 
always going to be transparent.

An often cited example of negative space is the Yin-Yang Symbol. It’s an interesting exercise to recreate one of 
these. I’ll start with a circle and I’ll give that circle a black, two point stroke. I’m now going to copy that to the 
clipboard. We’ll be needing this later. I’ll put the stroke back to none. Now we’ll choose my scale tool and because 
I’m working with artwork that has no fill and no stroke, I’m going to move to my Outline View Mode. And be-
cause it’s very important that I’m precise here, I’m going to get in nice and large on my view size.

I’ll hold down Alt or Option and click on the anchor point. I want a copy at 50% and then I’m going to drag 
down a copy from that to the bottom of the circle. I need to make sure that they line up exactly, which it looks 
like they do. Now with both of those selected, I’ll come to the Object Menu, Transform, Transform Each. I want 
copies of both of those circles at 25%.

I’ll now select all of the artwork, come to my preview, View mode, choose my Shapebuilder. And I can combine 
those two shapes, applying a color, and I can click on that interior shape to apply a color to that. Here’s where we 
need that circle that we copied to the clipboard. I will now paste that in front. And then we can group all of the 
artwork together. In this example, I want to show that sometimes the negative space not only between letters but 
within letters can be interesting.

Helvetica is known for having a tear-shaped counter inside the A. So if our logo has the word water in it, or if it’s 
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in any way water-themed, and we have an a in the logo name, perhaps we can explore this option. I’ve convert-
ed the type to Outlines but I need to go a step further. In fact I need to go two steps further. I need to first of all, 
ungroup that so that I can select the individual words and then so I can get to that counter I need to release the 
Compound Path.

Now the Compound Path has been released, I can come and select it, and I can apply a different color to it. We 
can also create negative space through repetition. I’m going to select this cat shape and copy it and then paste it 
back. With that copy that is pasted in back, I’m going to nudge it out and up and change its color. I’ll then repeat 
that, copy, paste in back.

Nudge it out, nudge it up, change its color. Now, it’s working at the top because it’s a relatively simple shape, 
down here it’s just getting visually confusing. So maybe, just maybe, if this were our logo, we can put some sort of 
enclosing shape around it. And make that into a clipping mask. We can also produce some interesting negative 
effects through the use of compound shapes.

Here I have two leaves placed on top of a field of black and overlapping that field of black. I’ll select those three 
elements, then come to my path-finder panel and I want to use this option here, Exclude. I’m going to hold down 
Option or Alt as I do this to make it into an editable compound shape. By which I mean I can now double click 
on any of those elements and move them around. And that positive, negative interaction will update.
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Color association (choosing logo colors)

	 “- The color or colors you choose for your logo should enhance the attributes of the company. Color con-
notations are cultural, personal and sometimes contradictory. Red symbolizes love, passion and strength. It also 
conveys danger and aggression. Pink is feminine, sweet and associated with childhood. Blue is calming, protect-
ing, professional and serious. It also carries connotations of authority and success. Brown is earthy, natural.

Orange conveys Autumn, Halloween and citrus fruits. Green is healthy, fresh, natural, fertile and organic. In the 
US, it’s also the color of money and can be associated with envy. Black is solid and powerful. It can also connote 
mourning and death. Gray is practical, earnest, traditional and creative. White is the color of peace, it connotes 
purity and in the medical context, it’s sterile.

Yellow is warm, happy and sunny. On the other hand, it’s also associated with cowardice. Purple is sophisticat-
ed and classy, it’s associated with affluence. There are positive and negative connotations to whatever color you 
choose, so don’t get hung up on these associations, but do be aware of them. Typically a logo has one prominent 
color, but there are many examples of logos that use multiple colors. Using multiple colors can convey diversity 
and inclusivity or a wide range of products.”
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Converting transperancy to tints

	 “- For my fourth example of recolor artwork, I’m going to use the scenario of a transparent logo that we 
need to reproduce in spot color. So, we need to make this into a two color logo. One of those two colors is the 
black of the type, so that leaves us one color and tints of that color to reproduce the symbol. Currently, if you 
look at the transparency panel, we can see that these different tints of green are achieved through the color burn 
blending mode. And if I move any one of those petals away, you can see that it’s actually just a single color.

I’m using color burn as opposed to multiply, just because I felt that color burn gives me three distinct greens and 
if we use multiply, that gives us four colors but there’s not much distinction between them. So, that’s the reason 
I’ve gone with color burn as my starting point. But we cannot reliably reproduce transparency using spot colors, 
so we need to first of all, jump through some hoops, here. And the first of those hoops is we make a copy of the 
logo, and we rasterize it.

Having done that, I’m then going to come and create an object mosaic using five by five tiles, which will give me 
that result, which is quite interesting in and of itself. I’m now going to make that object mosaic into a color group 
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using the selected artwork and I’m going to convert the process to global. We now have a color group of five 
colors, one of those is white, we don’t need that, so we can remove that, and these two greens are very similar, so 
I’m going to remove one of them.

So, that leaves us with just three. Now, I’m going to come to my logo, which I’m going to make a copy of so we 
can compare. And I’ll work on the top copy, just on the symbol. I’ll use the live paint bucket, and then make this 
into a live paint group. Now, we get a warning message telling us that, amongst other things, transparency is go-
ing to be lost when we convert it to a live paint group. Okay, we’re aware of that. Thanks for letting us know. So, 
I’ll come to my color group and choose that dark green color.

And it’s useful to have both open here because we can use one as a visual reference for how we’re going to apply 
these colors. So, there’s the darker green, the intermediate green, and then the lighter green is already applied 
to the outside portions of those petals. So, we now have distinct colors applied to distinct segments. I want to 
expand that. Here’e where the recolor artwork comes in. So, current colors: three.

We only have one color, so I need to map these two lighter greens to the darker green. The darker color has to 
take precedence, because that is going to be the color at 100%, so we need some room from which we can scale 
down. I’m going to drag both of those onto there, and you’ll see that currently, we are scaling tints. And that’s the 
result we get. And that is fine. Maybe that’s as good as we can get. But, we can also double-click on the color and 
change the color.

Now, when I was practicing earlier, the color that I came up with was this. 78, 196, 24 for the R G B values, 
respectively. So, these two lighter greens will now become a tint of that darker green, and then over here, where 
it says, “None,” we need to come to our color books, pantone solid coated. We’ll click “OK,” and there, on our 
swatches panel, we now have our one pantone color, pantone 360.

Let’s just open up our color panel, so there we see pantone 360 applied at 100%, at 68%, and at 46%. Now, we 
may decide that we want to edit it further from there just to make a bit more distinction. So, I think these inter-
mediate greens. I’ll select all of those, and I’m going to make that 50%. No, that seems to be too light. Let’s go 
with 60%, there, and then, the lighter greens, I’m going to make 35%.

So, as I warned you, the colors do look different, but, keep in mind, this is based upon multiple colors, this is all 
one color, and tints of that one color.
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Offsetting multiple paths

	 “- [Instructor] Here I’m going to how we can add multiple paths to an object, in this case, it’s going to be 
a piece of type, and this is suggested by the wonderful Mexico ‘68 Olympics logo. And on the left, we see my fin-
ished logo, and on the right, my starting point. The type, which is necessarily a thin and unadorned mono-white 
font, I’m using Lato Thin, which is available on Typekit, has no fill, and a black stroke.

A black stroke of 1 point. If you don’t have this font or access to it, then I have included a version the letters up 
here which have been converted to outlines, and you can use this instead. However, this effect is a live effect, and 
if you use real type, you will be able to edit the type afterwards. So, I’m going to select my type, I’m going to come 
to the Appearance panel, and first thing I will do is add a new stroke, black stroke, 1 point, and I’m not going to 
offset the stroke.

I’m going to do this using the Effect option, I’m going to do it here, Offset Path, you will need to vary the amount 
of offset according to the size of type that you’re using and the properties of your type. I’m going to go with 3 
points. The joins will be round. Let’s turn on the Preview, and we can see that’s what we’re going to get. Now, 
essentially, I just want to repeat that step multiple times but as the paths grow, they will overlap each other.

And we actually want them to join together, to be added together, so we need to add a second property to the 
stroke, and that is Pathfinder, Add. So having created one stroke, I’m now going to come to the bottom of the 
Appearance panel, and duplicate that selected item. I will click on the Offset Path, and just increase the amount 
of offset. I will double it.

Then we have a second stroke. And, you can probably guess that I’m now just going to do that multiple times. 
Duplicate the selected item, edit the one that is at the bottom of the stack, edit the amount of offset, and I’m 
going up by increments of three points. So let me just do that a few times. So make sure you’re clicked on to the 
path when you click Duplicate Selected Item.

Okay, I’ll stop there. Now, once you’ve done this, if you want to apply this effect to any other selected objects, you 
can save it as a graphic style. So if I come up here to my Graphic Styles panel, here is one I created earlier, and the 
style was based on the example on the left. So I could just apply this style. Let me just, before I do that, though, 
make a new graphic style for my currently-selected object, click on New Graphic Style, and I’ll double-click on it 
to name it.

And let’s see, I can now just apply my first graphic style to my selected type, and as I mentioned, this is a live 
effect, so I can, with my type tool, select the type and replace it with other type. So there, just a simple way to add 
multiple offset paths to a piece of type.
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Working with stripes

	 “- Let’s see how we can use Illustrator to recreate an approximation of the famous Woolmark logo, and 
this is my version. I’m going to turn my guides on by pressing Command or Control + Semicolon. Okay, I’m 
going to begin this by drawing a circle and then another circle on top of it, subtracting the top circle from the 
one beneath to create my basic crescent shape, so I’ll press L to access my ellipse tool, click on my art board, and 
I want an ellipse at this size, 250 by 250.

Let’s make sure that that is filled with black. Currently, it’s stroked with black, so I’m going to press Shift + X to 
swap those values, and now, I’m going to duplicate it, but I need to offset it a precise amount, so I’m going to 
come to the Object menu and choose Transform, Move, and I’m going to move it by minus 15 points. Vertically, 
it’s not going to move at all, and I’m going to make a copy, so now, with those two selected, I will come to my 
Pathfinder panel and subtract the top one from the one beneath.

I’ll keep it selected and then come to the Effect menu. Distort and Transform. I now want to make eight copies of 
it, and the offset is going to be 15 points horizontally and eight copies, and then I want to move it from the right 
hand, from one of the right hand reference points. Turn on my preview, just to make sure that’s right. Click OK.

I’ll now come to the Object menu and expand the appearance so that we now have nine crescents. So that I can 
color each alternating one in white, I’ll come to my Live Paint bucket and click, and make sure that white is my 
color, and then click into every other stroke. And then I’m going to expand the appearance of that so that it’s no 
longer a Live Paint group.

So this is our basic building block. Now the tricky thing is getting these three different segments to interact with 
each other in just the way that we want, and to do that, I’m going to come back to my ellipse tool and draw an-
other circle at the same size, and I’m going to position this relative to the fifth or the middle of our stripes. Right 
there, let’s make sure that this has no fill so I can see where I’m putting it.

That looks about right, and I’m going to convert this to a guide, so from the View menu, I will come and choose 
Guides, Make Guides or keyboard shortcut Command or Control + Five. So now using this guide, I’m going to 
draw a triangle on top of this. I’ll switch to my polygon tool and I’m going to draw the triangle from the center 
point of that circle, so I’ll position my cursor over the center point, hold down the Alt or Option key and the 
Shift key.

Now, if you need to add points or subtract points, you can use your up arrow or down arrow. Now, I’m going 
to draw this triangle until the base aligns with the bottom of our shapes, right there. Now I need to increase the 
size of this triangle so that its right side aligns with the right edge of our shapes, and to do this, it’s easier to do it 
numerically, so I’m going to switch to the scale tool and because I want the scaling to take place from the bottom, 
I’m going to Alt click on the bottom and increase that to a uniform scale of 101%.

I’ll click OK, and then I’ll just keep pressing Command or Control + D until the right side aligns with the right 
edge of our shape, like that, and then I’m going to convert the triangle into a guide, Command or Control + Five. 
I’ll now come and select our first building block and then duplicate this. I’m holding Option or Alt and dragging 
away from it, and then I’m going to rotate it, and I’m going to rotate it so that what is currently its left side aligns 
with the left edge of that triangle, and then position it like so, aligning its bottom to the base of that triangle, and 
then sending it to the back.

That is Command + Shift and the left bracket. I now need to repeat that. Hold down Option or Alt and drag away 
from it, and I now want to rotate it such that its currently right edge aligns with the right edge of the triangle, 
and I’m going to move that down into position. Right about there, I think, and then I’m going to send that to the 

back. Now, the tricky thing is, if I just deselect what we have there, is that we need to now fix the way these things 
are overlapping.

So I’m going to select this one, come to my Layers panel. I’m going to create a new layer, and I’m going to drag 
a copy of this top segment to that new layer. Remember, it’s a copy that we want, so I’m going to hold down the 
Option key or the Alt key and drag up, like so. I will now come and hide my edges so that you can see what I’m 
about to do next, and that is get the eraser tool, and I’m just going to rub out the bits that we don’t want to see, 
and if I hide my guides, Command or Control + Semicolon, there is our finished version.
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Creating a circular maze

	 “- In this movie, I’m going to use the Polar Grid tool to create a circular maze with a path to the center. 
This is my Polar Grid tool, right here, under the Line Segment tool. I’ll choose that, and I want to center it within 
this square so I’m going to just hold down my Command or Control key, click on the outline of the square, so I 
can see the center point, and Option or Alt click on that center point. Rather than draw the Polar Grid in a free-
form way, I’m going to do it numerically, ‘cause I know exactly what I want.

That is 400 by 400, concentric dividers will be six, that’s the number of rings, and the radial dividers, I’m going 
to have 32. So there is my beginning Polar Grid. I now want to increase the stroke weight, and I’m going to go 
with 16 points. Let’s modify this using the Layers panel. I’ll disclose the contents of the Begin layer, and then the 
contents of the Group on the Begin layer, and our Polar Grid is made up of the concentric rings and the radial 
dividers.

The radial dividers are the top of those two layers within the group. I’m going to select just that sublayer, and 
convert it to Guides, Command or Control + 5. Now I will select the concentric rings, and I’m going to add 
anchor points multiple times. Currently we have four anchor points on each ring. I want to end up with 64. So 
Path, Add Anchor Points.

That will double the number of anchor points, that take us to eight. 16. 32. And 64. Every time we do that, we get 
a new anchor point between the existing anchor points. So I’m going to use all these extra anchor points to chop 
a path from the outside of the circle to the center of the circle.

Let me just zoom in on this, so we can see where we’re going. And I’ll choose my Direct Selection tool. First of 
all, click outside of the selection to deselect, and then click on the anchor point where we want to enter, and press 
Delete. Now, when I do that, I get a Butt-end Cap, and I want a rounded end. So, I’m just going to come and 
select my concentric rings, and to the Stroke panel, and choose a Rounded Cap.

So now I can just customize my path to the center, clicking on the black ring at the point of the guide, and we 
should find that there’s an anchor point there, which we can delete. As we get closer to the center, we will need to 
delete more than one anchor point. I’ll press Command or Control + Semicolon to hide my guides, and there is 
our finished maze.



- 198 - - 199 -

Creating a patterned spiral

	 “- In this tutorial I’m going to create a version of the Munich1972 Olympic spiral. This tutorial is inspired 
by a tutorial by Diana Burg on vectordiary.com. What we have is a spiral divided into three segments, each seg-
ment filled with our radiating pattern, and the angular rotation of that pattern varied from segment to segment. 
But before I begin with that let’s just take a moment out to look at the Spiral Tool and how it works.

If I click with the Spiral Tool we see we have this very important option, the percentage of Decay and the number 
of Segments. So I’m going to create a spiral using my Ellipse tool first of all, just so that we can understand the 
percentage of decay. I’ll draw myself a circle, holding down Option or Alt and Shift to draw it outwards from the 
center point. I’ll switch to my Scissors Tool and I’m going to break the path at those two points, and then delete 
that portion, so we’re left with just the arc.

I’ll come to the Object menu, Transform, and Transform Each. For the Scale I’m going to use 80%, that is equiv-
alent to the percentage of decay. To start with I’m going to Reflect across the y-axis from the bottom right ref-
erence point. I’ll Copy that. Come back to Transform Each. Now I’m going to Reflect across the x-axis from the 
bottom left, Copy.

And back to Transform Each, this time using the keyboard shortcut Command + Option + Shift, or Control + 
Alt + Shift and D. Same amount of percentage. Alternate the axis that we are reflecting over, change the reference 
point. I’m moving around this reference square in a clockwise direction, and Copy. And I could continue each 
time adding a new segment. So that, I hope, explains exactly what the decay option is doing.

So with that knowledge I’m now going to come and click with my Spiral Tool. We want a spiral with a Radius of 
200 points, a Decay of 85%, 8 Segments, and wound counter clockwise. I’m going to rotate this through 180 de-
grees, holding down the Shift key as I do so. I’m now going to position this with a circle, so I’m just going to click 
to make my circle.

The Radius of my spiral was 200, the diameter of my circle will be 400. Let’s arrange these two relative to each 
other. And I want the circle to cut off the tail of the spiral over here on the left. I’ll switch to my Pen Tool, and I’m 
going to create a path segment from the open anchor point at the center of the spiral, I’ll click right there, hold 
down the Shift key, and move to the left.

I’ll now hold down the Command key and click outside of the selection to deselect. Now select the whole thing 
and using my Shape Builder Tool I will hold down the Option or Alt key and delete these segments that are out-
side of the circle that we don’t need, and then define the interior shapes as segments in their own right, and I’m 
also going to color them, just so that we can see them more easily.

Keeping everything selected, I’ll come to the stroke property and make sure that that is none. So let’s now move 
that to the center. The next thing we want to do is create our pattern and I’m going to do this on the pasteboard. 
I’ll create a circle, same size as the one before, 400 points. I’m going to make sure that circle has no fill, but does 
have a stroke. I’m just going to press Shift + X to flip my current properties, it doesn’t really matter what color the 
stroke is.

I’ll choose my Line Tool, hold down my Command key, and just click outside of the circle to deselect it, move 
over the center of the circle, so that I can see its center point, hold Option or Alt and Shift, and draw a line that 
connects with the outside of the circle, and then double-click on the Rotate Tool to rotate copies of this line 
around the circle. Now I want to divide my circle into 34 segments.

360 divided by 34, and I’ll Copy that. And to repeat that transformation press Command or Control + D, keep 
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pressing that until I come back to my first line. I’ll now select everything and I’m going to switch the fill and 
stroke properties, Shift + X, and then make sure that the fill color is white.

I’ll come to my Live Paint Bucket, click on it to make it into a Live Paint group. Now choosing black I want to 
make sure that each alternating segment is filled with black. Then I’m going to drag this over and position it ex-
actly on top of the spiral. Switching now to my Layers panel, which seems to have gone missing in action, so I’m 
going to open it up from under the Window menu.

And I’m on the Begin layer. What I want to do is position this Live Paint group beneath the color segment, so 
I’m going to need to make copies of it. First of all, I’ll just drag the one that I have under the green segment, and 
then holding down the Option or Alt key I’ll drag another one under the Yellow segment, and a third under the 
red segment. Now starting at the top I will select both the green segment and the Live Paint group beneath it and 
make that into a clipping group.
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Type on a cube

	 “- [Instructor] In this movie, I’m taking as my inspiration the wonderful Bread Box logo, which is just 
two pieces of type mapped to a 3D cube. Very simple, but very effective. So I’m using a five-letter word, and a 
three-letter word. I have a square that will become a cube. My type, which has been converted to outlines, it 
began as Balboa Extra Condensed, my type will need to be converted to a symbol before it can be mapped to the 
3D object.

But, preparation is really going to pay off here, so before I do that, I want to make sure the type fits over the sur-
face, and the word Mix does, no problem. Heady is more complicated because, as we can see, it goes across two 
surfaces. So I’m going to select my square, I’m going to copy, I’m going to paste it in front. Command + C, and 
Command + F. And then, on the copy that is in front, I’ll come to my left reference point, and increase its width 
to 120 millimeters, and then press Command or Control + 5, which will convert it to a guide.

So now when I move this down into position, I want to position the A exactly on the join. Let’s zoom in as close 
as we can. I’m now going to extend the width of the type, holding down the Option or Alt key, I’m going to drag 
that out until we reach the edge, or as close to the edge as we can get. We can see it’s not quite symmetrical, but 
that’s close enough.

So having made that adjustment to it, I’m also going to divide it into two, because that’s the best way I’ve found of 
getting a decent join put where the two parts of the word go across the two surfaces. To improve my chances of 
getting a good join, I’m going to zoom in really close on the type, and I’m going to make an adjustment to the A. 
You can see that the apex of the A, I’ve got these two anchor points.

I’m going to select them both with my Direct Selection tool, and then from the Object menu, I’ll choose Path, 
Average. I’ll average across both axes, that’s going to bring them together. So I now want to split this word into 
two halves. I’ll draw a rectangle over the left half, I’ll select the type, Command or Control + C, to copy that to 
the clipboard, and then I will come to my Pathfinder panel, and choose Crop.

Let’s just move that portion over there, Command or Control + F will paste in front the copy that was on my 
clipboard. I’ll now get the square. Now I need to move that over to the left, extend my selection, I think it needs 
to nudge over just a fraction more, extend my selection to the type, and crop that. So we’ve now got two pieces of 
that word.

I’m also going to rotate these through 90 degrees, and I’m going to do the same thing with the word Mix. Basical-
ly, I want to set this up as much as I can, so I need to do as little as possible in the 3D Map Symbol environment. 
So I’ll select these pieces one-by-one, and drag them onto my Symbols panel.

Click okay to make them into a symbol. I’ll now select my square, and give it the same color as the background. 
Come to the Effects menu, 3D, Extrude & Bevel. Now, to make my square into a perfect cube, then I need to 
make sure that the extrude depth is the same as the width and height, which is 60 millimeters.

And I want its position to be isometric left. So there is my cube, and I want no shading, although I’ll leave the 
shading on for now. Then I’m going to come to Map Art, we have six surfaces for our cube, and we’re going to be 
mapping as symbols to surfaces one, three, and six. You can tell which is the active surface by the red line.

So first up, we have surface number one, and that needs to have that symbol mapped to it. Now I may need to 
just position that, move that up ever so slightly. We do not have any nudge controls here, which is why I wanted 
to do as much as I could before I got to this point. So now, I’m going to move to surface number three, and then 

I’m going to move to surface number 6.

I’ll click okay, and then back here, I’m going to change that to no shading. So when we get back out here, we see 
that things almost, but not quite, line up. So there is the scope to go back, and just try and nudge things exactly 
into position, but you may also possibly find it easier just to simply draw a little patch over these areas, because as 
much as you try and get it exact in this environment, you can’t always do so.

Let’s see if I can get it a little bit closer, so turn on the Preview again, back to the Map Art, we see the symbols 
that we already added. And I’m thinking it’s surface number six, if I can maybe bring that down slightly, and then 
we’ll go back to surface number one.
And that’s actually pretty good. But, if we were finding that we really couldn’t remove the seams, then I would 
literally do this. Just on a layer above, locking the layers below, get in really close, and when we do get in really 
close, we see that things don’t quite line up. We can just draw ourself a shape like so, and apply the appropriate 
color to that.

Now that may seem a bit primitive, but it does work. And there is our finished result.
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Perspective extrusion

	 “- [Instructor] Let’s take a look at two different methods for creating a dramatic 3D extruded shadow. The 
first using the 3D Extrude & Bevel effect, and the second using the Blend tool. Starting out with this version, the 
type I’m using here is Prohibition. This is available on Typekit. I’m using this because the letters are blocky and 
because they have a flat, rather than a rounded, base. Now I’ve converted the type to outlines so you don’t need 
to worry about syncing the typeface with Typekit.

I’m going to select it, and come to Effect, Warp, Arch, and apply a 35% bend. Next, I’m going to come to the Ef-
fect menu again, 3D Extrude & Bevel. I’ll set the position to front, and then we turn on the Preview so we can see 
what’s happening here, and then I’m going to apply just a 10-degree rotation along the x-axis.

I will increase the extrusion depth massively to 2000 points and then to taper that extrusion, I’m going to get the 
perspective slider, and move that all the way to its maximum value of 160 degrees. Next, I want to affect the light-
ing, and I’m going to do this with my Lighting options. If you don’t see these, click on More Options. I need three 
lights.

The first, I will move to the top center of this circle. I’ll click on New Light, I’m going to move this one to the top 
left, another new light, which I’ll move to the top right. And what I want to make sure here, what I’m trying to 
achieve, is that there is some definition in the gray values that make up the shadow. I’ll then click okay, I’m now 
going to expand this. And come and chose my Direct Selection tool.

Let’s zoom in first of all. Back to my Direct Selection tool, I’ll deselect, select one of my letters, and then from 
the Select menu, Same, select the same Fill Color, to select all of my letters. And then I’m going to change the 
color of the letters to red, and switch to the Stroke, and apply a light yellow stroke, which I’ll just increase to two 
points.

Now so that I can’t interfere with those letters, I’ll come to the Object menu, Lock, Selection. I’ll swipe over the 
shadow, so that I can evaluate the change that I’m going to make, I’ll come to the View menu and hide the edges 
on that selection, and then come to my Recolor Artwork, where I’m going to map the gray values to the colors in 

my color group. I currently have 11 colors, and I want these to be mapped to the five colors in my color group.

So where it says here, Colors: Auto, I’m going to change that to five, I’m going to click on my Color Reduction 
options, change the colorize method from Scale Tints to Exact. I have white and black Preserve unchecked. So 
now that we’re working with just five colors, I will click on my color group, and there is the first of our two re-
sults. So let’s now move to the second example, and this time I’m going to create the extruded shadow using the 
Blend tool.

In this case, the type face that I’m using is Rosewood Standard Fill, and as I did before, I’ve converted this to 
outlines. The first step is the same, and that is the Warp effect, Arch with a bend of 35%. Now, at this point, what 
I want to do is make a copy of this, and offset it and reduce it. So I’m going to switch to my Selection tool, and 
then holding down my Option or Alt key, I’m going to drag away from that down to the bottom, and I am going 
to scale it, holding down my Option or Alt key and the Shift key, I’m going to scale it like so, and now I want to 
change the colors that I’m working with.

I want to blend to the yellow, but I need to make sure I’ve got the right property selected, I want to apply the 
yellow to the fill and not to the stroke, and I want the blend from the black. I’ll select the To, come to the Object 
menu, and choose Blend, Make. I’m going to need to change the stacking order of the top blend object and the 
bottom blend object. If we look at the layers panel, disclose that and disclose the blend, we can see that the yellow 
is above the black.

It needs to be the other way around, so I’m just going to change that. And then, I will double-click on the Blend 
tool, and change the spacing from Smooth Color to a Specified Distance, and that distance, in this case, is going 
to be 0.2 points. Let’s turn on the Preview and see what that gives us. To make my blend more rich, as in the ex-
ample of the finished version on the left-hand side, I need to change the color of the black object.

Let me just first click okay to accept those blend options, and now, using my layers panel once again, I’m going to 
select the topmost object, the black object, and the problem is that the black that is applied is a single-color black. 
There’s no magenta and there’s no yellow in that black. So I am going to change that by coming to my Swatches 
panel, and applying this four color, or actually three color, black in this case.

And that’s going to make for a much richer blend. If I just double-click on this black to edit it, you can see as well 
as the 100% K, there is also 100% magenta and 100% yellow. Now, to finish the effect, once again I’m going to 
return to the Layers panel, because I want to duplicate the black object, and change its color to red. And I need to 
make sure that the copy that I make is outside of the blend group.

So I will hold down my, let me just switch to my Selection tool now when I do this, I will hold down my Option 
or Alt key, and drag up this sublayer above the blend group to make a copy. With that copy still selected, I will 
come to my Swatches panel, and apply the red color to it. So there we see our two quite-different approaches to 
creating a dramatic 3D extruded shadow using the Blend tool, and using the 3D Extrude & Bevel.
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Creating a shaded shadow

	 “- Adding shadows and dimension to your type can convey drama or perhaps nostalgia. And in this 
movie, I’ll show you how to create a shaded shadow. Begin by zooming out, Command or Control + zero. On the 
right-hand side we have our starting point. This type is Clarendon Text Pro Bold which is available on Typekit, 
but I’ve already gone to the trouble of converting this to outlines so that you don’t have to worry about syncing 
the font. First thing I want to do is select the outlines and copy, then return to the Edit menu and Paste in Back.

So I now have two identical copies on top of each other. I’ll come to the Effect menu, Distort and Transform, 
Transform. And I’m now going to create multiple copies of that shape, each one offset very slightly from the one 
that came before. So for the move values, I’m typing in a very small distance of 0.1 of a point. And then I’m going 
to have 120 copies.

Let’s turn on the preview and see what that’s going to do. Obviously, if you want to extend your shadow further, 
increase the number of copies. I’ll click OK. Now as shadow currently made up of 121 shapes, we need to com-
bine them all into one. So I’ll need to come to the Object menu. First of all, Expand Appearance. Return to the 
Object menu, Expand. And one final step to combine all these shapes into one, come to the Pathfinder panel, and 
using the first of the shape modes, add them all together.

Now with a single shape representing our shadow, I’m going to apply a pattern. I’ll come to the swatches panel. 
I got it from one of these predefined patterns, Basic Graphics_Lines. And these are currently being viewed as a 
small list. The one that I chose is 10 lpi 30%. I’m now going to transform the pattern itself. So I’ll return to the 
Effect menu.

And since Transform was the last effect I used, it’s the second item under the Effect menu. I’ll choose that. I want 
to make sure I clear out any previous values. So I’ll set the move back to zero and the copies I will set to zero as 
well. And in this case, I do not want to transform the object, so I’ll uncheck that. But I do want to transform the 
patterns. I’m going to set the scale for the pattern to 50%, both horizontal and vertical, and the rotate angle to -45 
degrees.
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Let’s turn on the preview, and you can see that’s what we’re going to get. I’ll click OK. Optionally, I can change 
the shading of the pattern. And I can do that by double-clicking on the pattern tile which takes me to the pattern 
editor. I can now select the elements that go to make up that pattern and change the stroke color. I’ll come to my 
colors panel, Show Options. I’ll change the stroke color from 100% black to 50% black.

Now when I leave the pattern editor, we can see that that updates in place.
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Creating an offset shadow

	 “- Let’s see how we can get this popular offset shadow look. On the left, I have the finished version, and 
on the right, my type currently Museo Sans 900, 130 points. This is available for syncing on Typekit. If you don’t 
have access to Typekit, then you can use this version on the pasteboard that has been converted to outlines. The 
reason I’m working with the type as type is that this is a live effect, and the type will be editable throughout.

So with it selected, I’m going to come to the appearance panel and start by adding two fills. Let’s just take a look 
at the swatches panel. The colors that I’ll be using are the pink, the color of the background, this blue-gray, and 
a gradient is a blend between those two colors. On my top fill, I will change the fill color to the pink. On the fill 
beneath, I’ll change it to the gradient. Returning to the top fill, I’m now going to apply a 3D extrude and bevel 
effect to this.

The angles of rotation that I want for the X, Y, and Z axis are three, three, and zero, respectively. Let’s turn on the 
preview. And then I want to increase the extrude depth to 100 points. If you don’t see your lighting options, click 
on more options. I’m going to move the position of the light to about the nine o’clock point and then slightly in 
towards the center of the circle.

Finally, in this dialogue, I’m going to change the shading color. Shading color currently black, I’m going to 
change that to custom, click on the color swatch, click on the color swatch’s button, that takes me to my swatches 
panel, and I’m going to use the blue gray color as the shading color. I’ll click okay. Now I’ll select the fill beneath 
that that is filled with the gradient and come to the effect menu. Distort and transform, transform.

So here what I want to do is offset multiple copies. I’m going to change the move to 0.3 for the horizontal, and 
the same distance for the vertical. And then number of copies, I will set to 250. Now with that many copies, each 
one offsets such a small distance from the one that came before it, should be enough to ensure that we don’t see 
any jaggies as we move from one copy to the next.

I’ll now click okay, I will choose my gradient tool, so that I can use my gradient annotator to adjust the position 
of the gradient. I’ll move to the right-hand edge of this, and then I’m going to spin it around, and move it up like 
so, and just adjust it so that the gradient clearly begins at the top of the letters and continues all the way down to 
the bottom of the letters.

If you want your gradient to extend outside of the frame, then we can just come back and adjust the number of 
copies, let’s say that we have 1,000 copies. I can then select the background rectangle, copy that, select my type, 
paste a copy of the background rectangle in front of the type, press the forward slash to set its fill color to zero.

That’s going to allow us to select the type through that, so with top rectangle and type selected, come to the ob-
ject menu and choose clipping masks, make.”
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Preparing print files

	 “- Print versions of the logo will be supplied in a vector file format, so that they’re scalable. AI, EPS, and 
PDF are all vector file formats. These days the native Illustrator file format, AI, can be placed in just about any 
sort of page layout program, but for maximum compatibility I’ll be saving the print versions in EPS format. De-
pending on your clients needs you may want to save versions in both AI and EPS.

This is arguably redundant, but it won’t do any harm. Before we do so, let’s just check a few things. Firstly, we 
want to convert all fonts to outlines. Make sure you’re working with a copy of the file here, because you want to 
retain your original with the type as editable text. But for public versions of the logo the type should be outlined. 
Even if the logo is all text think of it as a picture. There should never be any possibility of people editing the text, 
nor any chance of the type changing due to missing fonts.

Secondly, expand all effects. This removes the possibility of any unpredictable behavior when scaling the logo. 
Look what happens here when I scale this, how the relationship between the type and symbol is completely dis-
rupted. This symbol has been created using a Transform effect. I’m now going to Expand the Appearance on that 
effect, so that now if the logo is scaled the relationship of the elements is maintained.

Consider creating variants of the logo, like a version that includes the company tagline and the reverse version. 
Supply each variant as a separate file with a file name that clearly indicates its intended usage. While you can just 
copy and paste each variant into a separate file and then save it, you can also somewhat automate this step. I want 
to put each of these variants on a separate Artboard and then export all of the Artboards in one go.

If we look on the Layers panel and disclose the contents of the Layers panel we see that in each of the groups 
corresponding to the three different logos there is a white rectangle, which represents the designed clear space 
around the logo. I could convert this to an Artboard, like so, but in doing so I would lose that solid white rect-
angle. So rather than do that I am first going to select those rectangles, I’m holding down the Command key and 
clicking on the bullseye for each of these sublayers to select them, and then I will press Command + C to copy, 
come to the top of my layer, and from the Edit menu choose Paste in Place.

I will now come to the Object menu, Artboards, Convert to Artboards. We now have four Artboards, and if I 
come to Artboard number one we see that Artboard number one includes Artboards two, three, and four. With 
the Artboard Tool I’ll delete Artboard number one. I can use my Artboard panel to reorder these Artboards, but 
that’s not really necessary. I’ll now just come to the File menu and choose Save As.

I’ll change the file Format to Illustrator EPS, Use Artboards, All, Save. Here I want to backsave to an earlier 
version, just to increase the compatibility. It does warn me that certain features will not translate, but I know that 
I haven’t used any of those in this case. Now if we take a look at that in Bridge we see that we have the, I’m just 
going to switch to my Filmstrip mode, it’s created our master file, print.eps, with all three versions of the logo, 
and then we have each one as a separate file.

To complete this step I’ll rename the files, so there’s no ambiguity about how they should be used.”



- 228 - - 229 -

Preparing screen files

	 “- [Instructor] I’ll be saving the screen versions of the logo in the PNG file format. I’ll save separate ver-
sions at different sizes because unlike the vector print versions, the screen versions are not scalable. The actual 
sizes you use will depend upon your client’s needs and the shape of the logo. I’ll be preparing three versions at 
the following sizes: 100 pixels wide, 250 pixels wide, and 500 pixels wide.

I’ll come to the file menu and choose save for web. Change the format to PNG, eight bit. Transparency is not 
an issue here because I’ve incorporated a white bounding rectangle into the art, so having this checked or un-
checked is not going to make any difference, but I will uncheck it. I will chose no dither, but likewise, that’s not 
really going to make any difference because using the selective color reduction algorithm, we have ample colors 
to render our logo.

Clip to artboard is also unnecessary in this case because of the white bounding rectangle. Art optimized and 
type optimized, there’s no difference between the two because we’ve converted the type to outlines, so technically 
everything is art. I would change the size, typing in the width, press my tab key to have that update. Save, where I 
will give the file an explicit name. File format, images only.

I’m now returned to my Illustrator art board, and I can repeat that process for the other sizes. We can automate 
this process, so if you prefer not to do it just one by one, here’s an alternative way. In this document, you can see 
that I’ve created slices and I’ve created the logos at the actual sizes that they will be exported. So returning now to 
this version, let’s see how that was achieved.

I’ll select the one that we have, and I’ll come to the transform panel. I’m in pixels is my unit of measurement. I’m 
going to make the width on that 100, making sure that I’m constraining proportions. I’ll come and park that over 
in the top left, and then duplicate it by holding down option or alt, and dragging away from it. I’ll come to trans-
form, increase the width 250. I’ll now duplicate that one, increase its with to 500.

I’m then just going to select those two logos, making sure that I am aligning to selection, and align their left edg-
es. I now want these to be converted to slices. So one by one, I will select them, and come to the object menu and 
choose slice, create from selection. When we use save for web to export these slices, their file names will just be 
user slice one, user slice two, et cetera, so we could take this a little further and come and choose the slice selec-
tion tool.

Select the slice, and then from the object menu, come to slice, slice options, and I’m going to call this logo 100 
px. I’ll then repeat that for the other two versions. Logo underscore 250 px, I’ll now come to save for web.

Down here where it says export, I want to make sure that I am only exporting the user slices, i.e. the ones that I 
defined. Same file format as before, png eight bit, all the other options remain the same. I will now click save for 
the name, and this name will precede each of the slice names, I’ll just make that logo underscore. I’m exporting 
the images only.

And if we go to Bridge, we see that a folder has been created called images, and in that images folder, I’ll just 
return to my essentials workspace. We have these three different variants, 100, 250, and 500.
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